Micro Focus
Enterprise Developer 3.0
for Eclipse
Release Notes

Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com

Copyright © Micro Focus 2017. All rights reserved.
MICRO FOCUS, the Micro Focus logo and Enterprise Developer are trademarks or registered
trademarks of Micro Focus IP Development Limited or its subsidiaries or affiliated
companies in the United States, United Kingdom and other countries.
All other marks are the property of their respective owners.
2017-07-12

ii

Contents
Micro Focus Enterprise Developer 3.0 for Eclipse Release Notes ................ 4
What's New ......................................................................................................... 5
Significant Changes in Behavior or Usage ....................................................15
Known Issues ................................................................................................... 22
Resolved Issues ............................................................................................... 24
Other Issues Resolved in This Release ........................................................ 59
Unsupported Functionality ..............................................................................61
Installation ........................................................................................................ 62
Before Installing ................................................................................................................ 62
Downloading the Product ....................................................................................... 62
On Windows ........................................................................................................... 62
On UNIX ................................................................................................................. 64
Basic Installation ............................................................................................................... 67
Installing on Windows .............................................................................................68
Installing Micro Focus Enterprise Developer UNIX Components ........................... 68
Advanced Installation Tasks .............................................................................................. 69
On Windows ........................................................................................................... 69
On UNIX ................................................................................................................. 70
Installing on Microsoft Terminal Server and Citrix .................................................. 71
Updates and SupportLine ...................................................................................... 78
Copyright and Disclaimer ....................................................................................... 80
After Installing ................................................................................................................... 80
Configuring Enterprise Developer .......................................................................... 80
On Windows ........................................................................................................... 81
On UNIX ................................................................................................................. 82

Licensing Information

...................................................................................... 84

To start Micro Focus License Administration
....................................................................84
Installing licenses .............................................................................................................. 84
If you have a license file ......................................................................................... 84
If you have an authorization code ...........................................................................85
To obtain more licenses .................................................................................................... 86

Updates and SupportLine

................................................................................87

Further Information and Product Support ......................................................................... 87
Information We Need ........................................................................................................ 87
Creating Debug Files ........................................................................................................ 89

Copyright and Disclaimer

................................................................................ 90

Contents | 3

Micro Focus Enterprise Developer 3.0 for
Eclipse Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview
Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.
The Application Workflow Manager section in General Reference explains the mainframe integration and
mainframe modelling features of Enterprise Developer for z Systems.
Note:
•

The Application Workflow Manager is available within all Enterprise Developer variants and
provides all the capabilities and tools to develop and maintain Application Workflow models. These
models allow you to integrate tools and processes directly into Enterprise Developer. You can use
the Application Workflow Manager with the following products:
•
•

Enterprise Developer - the Enterprise Developer setup file automatically installs the Application
Workflow Manager.
IBM Rational Developer for System z (IDz) - see Installing Application Workflow Manager into
Rational Developer for System z (IDz) in the installation instructions. This requires that
Enterprise Developer Connect is installed and licensed.

Upgrading from earlier Micro Focus products
Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise
Developer in the product Help.
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What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Integration with Eclipse
Application Server JCA support for Enterprise Server
Application Workflow Manager in Enterprise Developer
Building applications
Character encoding
CICS Web services
COBOL language enhancements
Code analysis
Code coverage
Compiler control
Data File Tools
Database access - HCO for DB2 LUW
Database access - HCOSS
Database access - MySQL
Database access - OpenESQL
Debugging applications
Deployment on multiple platforms
Documentation
Enterprise Server
iFileshare
IMS support
Mainframe Access (MFA)
Micro Focus Unit Testing Framework
PL/I support
Rumba terminal emulator
XML processing
z/Server

Integration with Eclipse
This release provides enhancements in the following areas:
•

Support for Eclipse 4.6 - Enterprise Developer now ships with the 64-bit Eclipse 4.6. By default, Eclipse
is configured to compile applications for 32-bit and the default target platform for new projects is 32-bit.
Note: Applications that were created using Enterprise Developer 2.3 Update 2 and earlier must be
recompiled in Enterprise Developer 3.0 to ensure they will compile and execute properly.
The 32-bit Eclipse is still supported on 64-bit Windows platforms and you need to manually install the
32-bit IDE and a 32-bit Java

•

You can install the Enterprise Developer plugin in other instances of Eclipse (32-bit or 64-bit). Support
for Eclipse 4.2 and 4.3 has been discontinued.
Rename refactoring - enables you to rename COBOL elements such as variables and identifiers,
section and paragraph names, classes, and methods across a program or a workspace. Renaming
helps improve the readability of an item or make its purpose clearer. Two preferences for renaming are
supported in Eclipse - directly in the editor or using a Rename dialog box that offers a preview.
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•
•

Dependency paths - it is now possible to specify dependency paths to folders that are outside the
project folder.
Standalone files:
•

•

•
•

It is now possible to specify the locations where the IDE will search for the program symbol files
(.idy) for standalone files: Window > Preferences > Micro Focus > COBOL > Standalone Files
> Program Symbols (.IDY).
It is now possible to use the Eclipse debug configurations to debug standalone files, including core
dump files.

In previous versions of Enterprise Developer, standalone files were known as "single files". References
to "single files" in the IDE and the product help have been changed to "standalone files".
Error reporting - errors reported in the Console view now include a link for opening the source file at the
line where the error originates.
Editor improvements - an option for removing trailing whitespaces has been added to the IDE
preferences for the COBOL and the PL/I editor.

Back to Top
Application Server JCA support for Enterprise Server
In this release, EJBGEN has been updated to generate an EAR file as a part of the COBOL deployment
process, which enables you to deploy EJBs to Java Application Server.
Back to Top
Application Workflow Manager in Enterprise Developer
This release includes improvements in the following areas:
•

Application Workflow Manager model editor:
•

•

The definition of linked element types and properties has been improved. Some required model
objects and relationships are now generated automatically.
• The editor now detects unused references in a model.
Application Workflow Manager modeling:
•
•

Basic resource processing has been extended to support mass processing where appropriate.
The AWM function package now includes the following new tools:
•

•

"Return Property Value" - enables you to map the values of input parameters to output
parameters.
• "Validate Value" - enables you to validate a filename against a specified naming convention.
• You can now specify enabling conditions in a more granular way. An additional condition type has
been introduced to hide actions or properties. For example, hiding an action from the context menu
of an element.
• The Eclipse linked element type now enables the label and label decorator to be automatically set to
mirror their representation in other Eclipse views if they are not explicitly modeled.
• Table columns can be modeled as a combination of two or more properties - for example, to combine
a date and time property value.
• Additional standard icons.
Mainframe Access (MFA) integration and the MVS function package:
•
•

MVS resources are now available as linked element types.
The following tools have been added to the MVS function package:
•
•
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Delete MVS data set or member
Rename MVS data set or member

•

• Copy MVS file to clipboard, Paste MVS file from clipboard
• Get data set or member attributes
• Improvements have been made to copy and paste support in the MVS Explorer.
• File mapping between z/OS and local files now supports additional local code pages.
• The editor context menu contains a "Submit to Mainframe" action when a file is opened from the
MVS Explorer with an extension which is mapped to JCL in the File Mappings view.
• Some of the new MVS function package tools replace existing ISPF function package tools resulting
in improved performance of the tools.
• The sample model "MVS Projects Sample Application" has been improved by including some of the
new AWM MVS function package features.
AWM is now available as a standalone feature which you can install into a separate instance of the
Eclipse IDE installed on your machine.

Back to Top
Building applications
This release provides the following improvements:
•

Support for faster, parallel building on multi-CPU machines - support has been added for multiprocessor compilation of the sources in native COBOL projects on multi-CPU machines.
You can specify the maximum number of concurrent compilations from the IDE preferences - Window >
Preferences > Micro Focus > Builder.

Back to Top
Character Encoding
A new utility, cobutf8, is available. cobutf8 enables you to seamlessly run applications that require nonUTF-8 character encodings in a UNIX environment that is using a UTF-8 locale.
Back to Top
CICS Web Services
In this release, CICS Web services support includes the following additional features:
•
•

CICS JSON Web services for request/response and RESTful JSON. CICS Web Services support has
been extended to allow JSON/REST requests to be used in both requestor and provider mode.
Use of container-based mappings

Back to Top
COBOL language enhancements
This release includes the following enhancements to the COBOL syntax:
•

The DISPLAY-OF and NATIONAL-OF intrinsic functions are now able to process conversions using any
IBM CCSID value.

The following enhancements are available in managed COBOL:
•

To avoid an exception being thrown if an explicit conversion fails, use the AS IF syntax, which results in
the target object being set to null and no exception thrown.

Back to Top
Code analysis
This release provides the following improvements:

What's New
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•
•

A new group of predefined rule sets for 64-bit readiness is now included in Enterprise Developer.
Support for importing code analysis reports produced with one of Micro Focus's advanced tools for code
analysis, Enterprise Analyzer or COBOL Analyzer.

Back to Top
Code coverage
The following improvements are available within the IDE:
•
•
•
•

Information about unexecuted programs - the code coverage reports in the Code Coverage window
now show the unexecuted programs.
Code coverage support for standalone COBOL files - you can import existing code coverage reports in
the Code Coverage window and use it to supply code coverage information for standalone files.
Remote code coverage files - in the Code Coverage window in Eclipse, it is now possible to import
code coverage report files that are stored in remote locations.
Test coverage files - it is now possible to use a test coverage file to debug applications.

If you are using Test Coverage from the command line, you can now use the following features:
•

•
•

A new Compiler directive, COLLECTION - the directive enables test coverage to gather information
about unexecuted programs. In the IDE, this directive is automatically set on a project when you enable
code coverage for it.
A new command line utility, tcutil - the utility enables you to convert the test coverage binary results file
into XML format.
It is now possible to integrate test coverage in a Continuous Integration (CI) system. You can use tcutil
and an XSLT processor to transform test coverage data into a format suitable for including in a CI.

Back to Top
Compiler control
The following Compiler directive are new in this release:
•

COLLECTION - provides a mechanism for code coverage to identify unexecuted programs.

The following Compiler directives have been updated:
•

•
•
•
•

ALIGN - this directive has new parameters (FIXED and OPT) that can be used in conjunction with the
integer taken, which can aid performance. The default is ALIGN"8 OPT"; see the Comments section of
the ALIGN Compiler directive topic for details of its affect on memory boundaries.
ARITH - this directive emulates the IBM mainframe option of the same name. Defines the maximum
number of digits for numeric data items.
FASTINIT - this directive is now on by default when setting the MF dialect; it remains not set by default
for other dialects.
SSRANGE - this directive now has an additional option (3), which permits zero-length reference
modified items at run time when bounds checking.
XMLPARSE - includes a change in the way entities are processed when XMLPARSE(COMPAT) is set

Back to Top
Data File Tools
This release provides the following enhancements to Data File Tools:
•

•
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Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.
Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
provide a user ID, group and a password when they try to access and view datasets in enterprise server

•

•
•
•
•

instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.
Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.
This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.
Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.
Support for existing .pro files - enables you to use your existing editor profiles.
Support for existing .str files - enables you to use your existing COBOL and PL/I structure files.
Automatic timeout - if no internal operations or external actions (such as a mouse click) have been
detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.

Back to Top
Database access - HCO for DB2 LUW
This release provides a new DB2(QUALIFY-CALL) Compiler directive that enables stored procedure
invocations to include a schema name.
Back to Top
Database access - HCOSS
This release provides a new Offline Schema Extract feature – a batch solution that migrates a z/OS DB2
catalog to SQL Server without direct access to z/OS DB2.
Back to Top
Database access - MySQL
This release provides support for MySQL with ODBC.
Back to Top
Database access - OpenESQL
This release provides the following new features:
•
•
•
•

Statement prefixes for the SQL(CHECK) Compiler directive that enable the creation of temporary tables
and other SQL objects at compile time, ensuring full SQL syntax checking during compilation.
SQL(OPTIMIZECURSORS) Compiler directive that enhances processing for traditional embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses.
SQL(CLOSE_ON_COMMIT) Compiler directive to leave cursors open for further result set processing
after a commit.
SQL(GEN-SQLCA) Compiler directive that generates an SQLCA similar to the z/OS DB2 directive
STDSQL(YES).

Back to Top
Debugging applications
This release provides the following new features:
•

Debugging core dump files without a project.

Back to Top
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Deployment on multiple platforms
This release provides support for deploying JVM COBOL applications on multiple platforms. You can
compile an application on one platform (such as Windows) and then deploy its class files to a different
platform (such as Linux or UNIX).
Some features of the COBOL language, however, are platform-specific and their behavior on different
platforms might vary. See Multi-Platform Deployment of JVM COBOL Applications in your product Help for
details.
Back to Top
Documentation
The following new sections have been added to the product help:
•

•
•

Where do I start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.
Multi-Platform Deployment of JVM COBOL Applications - includes information about how to ensure the
portability of your JVM COBOL applications between Windows and UNIX or Linux platforms.
Configuring an SSL Client Connection to a Mainframe - includes instructions about how to configure
client applications to connect to MFA and z/Server mainframe via AT-TLS in a zOS environment.

Back to Top
Enterprise Server
Improvements are available in the following areas:
Integration with Eclipse:
•
•

Exporting an enterprise server definition from the IDE in XML format.
Importing an enterprise server into the IDE using its definition file.

EXEC CICS TRANSFORM:
•

Enterprise Server now supports the XMLTODATA and DATATOXML options of this API.

JCL spool
The JCL spool repository infrastructure has been redesigned to significantly improve its performance. The
improvements include:
•
•
•

•

A more disk-efficient infrastructure, reducing the space required by the spool files by up to 75% in some
cases.
Improved internal indexing, resulting in quicker generation of messages and sysout records during
processing.
Improved navigation of spool queues: job status Complete replaces the Output, Out Hold, and
Printed statuses, and completed jobs with any combination of sysout files can be displayed in a single
list.
Increased range of job numbers, from five digits to seven digits.
Important: These changes are automatically in place for new enterprise servers that you create.
To enable these updates to existing enterprise servers, you must run a conversion utility before
any JCL processing is permitted. Follow the To run the spool conversion utility process,
detailed in Significant Changes in Behavior, for each existing JES-enabled enterprise server you
have.

Long user IDs and passwords:
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•

Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.

Multi-factor sign-on:
•

Multi-factor authentication enables users to sign on to Enterprise Server CICS without entering a
username and password. A secure user identifier, such as a certificate, is mapped to a username and is
used to generate a passtoken. It is possible to use smartcards, biometrics, or other authentication
systems to identify yourself to the system. The username and passtoken can then be used to log on to
CICS in an automated way.
The supported sign-on mechanisms are Express Logon Feature (ELF) and Automated Sign-On for
Mainframe (ASM). See the product Help for examples of how to configure a region to use the two
mechanisms.

SHA-256 support in DemoCA:
•

By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:
•

Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

Back to Top
iFileshare
iFileshare is no longer considered an Early Adopter Program, and contains the following enhancements in
this release:
•

An improved failover and recovery process. iFileshare now supports full recovery of nodes in the group.
For high availability (HA-VSAM) groups, servers can now rejoin the group without the entire group
having to be restarted. In addition:
•
•

•
•
•

A primary failover now results in a takeover from the most suitable node.
If configured, external clients will automatically reconnect to the new primary and will issue a
notification if the transaction has been lost.
• A failed node, when restarted, will rejoin the group, recover its files and request a log update from
the current primary. Once this task has completed it will be considered an active hot-standby and will
continue to process replication requests as normal.
• Users will experience a higher level of uptime/availability with their Fileshare configuration and will be
able to recover from errors more easily.
A new exit procedure, ifsexitproc.cbl, can be configured to automate some aspects of iFileshare
behavior.
The iFileshare Control page in ESMAC contains details of the current iFileshare high availability group.
The following new iFileshare-specific environment variables are available:
•

•

FSWRKDIR - enables you to specify the Fileshare working directory, overriding the default, which is
the system directory of the region.
• FSCHKLFH - determines if a check is performed when a high availability group is started, to test the
consistency of the data files within the group.
The database reference file (dbase.ref) now supports wildcard matching for filenames, allowing you
to perform operations on multiple files at once; for example: fs /d dbase.ref /f data\* adds the
entire contents of the data directory to the database reference file.

What's New
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Back to Top
IMS support
A new MFSGEN Compiler directive, CONTMVS, has been added to enable the compiler to parse MFS
continuation lines (those continued without a terminating comma) by treating the line that follows as a
comment line, just as is done on the mainframe.
Back to Top
Mainframe Access (MFA)
This release provides the following improvements:
•
•

•

•

Running MFA client in 64-bit processes - you can now call the MFA client modules from 64-bit
applications and take advantage of the wider memory addressing available to those modules.
MFA client CTF tracing - MFDAS now supports CTF tracing. This provides better diagnostics of issues
and helps increase turnaround on issues. CTF is common to a number of Micro Focus modules so
cross-component logging can be turned on from a single place.
MFA and z/Server holder close coupling - MFA server can now start the z/Server holder as a subtask in
its own address space. This helps improve the performance as MFA can hand-off AWM sessions
directly to the z/Server scheduler without instructing AWM to redirect them.
Endevor functions - the following functions are now available to Enterprise Sync and MFDAS: DELETE,
DIRX, GENERATE, GETENQI, LIST, MOVE, SIGNIN and TRANSFER.

Back to Top
The Micro Focus Unit Testing Framework
The Micro Focus Unit Testing Framework is now available from within the IDE. It includes much of the
architecture you would expect of an xUnit framework to create, compile, run and debug unit tests, including
the following features:
•
•
•
•
•

A unit test project template.
A test creation wizard that enables you to generate tests from your source code.
Code templates for each element of a test case.
Support for running tests with Code Coverage enabled.
The Micro Focus Unit Testing view, where you can manage your test runs and view test output.

There has been a number of enhancements to the command line version of the Micro Focus Unit Testing
Framework. Support has been added for:
•
•
•
•
•

Running test fixture files using Apache Ant.
Applying traits to your test cases, then performing a test run based on those traits.
Applying a high, medium, or low priority to test cases, which affects the order in which they are run.
Adding coded command line options directly into your test code.
Using a test run-specific configuration file, in which you can set environment variables.

Back to Top
PL/I support
Enhancements are available in the following areas:
PL/I debugging
•

12

| What's New

New Eclipse-based PL/I debugger - the CodeWatch debugger has been replaced with the debugger
within the industry standard Eclipse User Interface. New features such as true remote debugging are
now available along with a much simplified user debugging experience that works in exactly the same
way as the debugger works for COBOL (and Java). This can help improve the productivity of PL/I

application developers who are adding new features or migrating existing applications to a distributed
world.
A selection of features which are now supported includes:
•
•
•
•
•

Attaching to a running PL/I process, waiting for attachment from a PL/I process
Breakpoint-setting in the editor
Stepping through PL/I code and querying the contents of PL/I data items
Viewing the execution stack, resetting the executions point, and running to a selected line
Remote debugging of PL/I applications running on Linux or AIX machines

PL/I compiler and run-time system
Support has been added to enable the following:
•

•
•

•

The UNSIGNED data type - the PL/I Compiler now supports the UNSIGNED attribute for FIXED
BINARY data items. In addition to the basic language support, the SIGNED, UNSIGNED, ISIGNED, and
IUNSIGNED new built-in functions have been implemented. These features offer an improved
compatibility with other languages such as C or C++.
New built-in functions - UTF8(), UTF8TOCHAR(), UTF8TOWCHAR(), and SUBTRACT(). These new
build-in functions make it easier to modernize migrated PL/I applications.
The ENTRY LIMITED data attribute - the Open PL/I Compiler now accepts and fully supports the
LIMITED attribute on ENTRY declarations. This increases the compatibility of the Micro Focus PL/I
Compiler with IBM's PL/I for applications that you are migrating from the mainframe.
Support for processing of JSON data - a number of new built-in functions are available for processing
JSON text. This enables you to modernize your PL/I applications by enabling them to interpret, create
and process JSON data.
JSONGETARRAYEND

JSONPUTARRAYEND

JSONGETMEMBER

JSONGETARRAYSTART

JSONPUTARRAYSTART

JSONGETVALUE

JSONGETCOLON

JSONPUTCOLON

JSONPUTMEMBER

JSONGETCOMMA

JSONPUTCOMMA

JSONPUTVALUE

JSONGETOBJECTEND

JSONPUTOBJECTEND

JSONVALID

JSONGETOBJECTSTART

JSONPUTOBJECTSTART

PL/I macro preprocessor
A number of enhancements have been made to improve the compatibility between the PL/I macro
preprocessor and IBM's macro preprocessor which helps ease the effort required to migrate PL/I
applications to new platforms. Support is available for:
•
•
•
•
•
•
•
•
•

RESCAN in the ANSWER statement.
The shorthand "<>" syntax for indicating "Not Equal To".
Break characters in hex literal constants to improve readability of code.
A new option, -tagdbg, that annotates macros and %FILE/%ENDFILE statements with line numbers and
the source file which injected them.
The -caseasis option which allows source code to flow through to the mdeck.pp file retaining the case
as entered.
Macros with a null parameter list.
The LEAVE statement.
Improved macro preprocessing speed.
New built-in functions: SYSENDIAN() and MFPHOSTNAME().

Back to Top
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Rumba terminal emulator
Enterprise Developer now ships with Micro Focus Rumba 9.5.
Back to Top
XML processing
XML PARSE now works in a purely managed COBOL environment. It is now supported in JVM COBOL
and, in both .NET and JVM COBOL, it has a fully managed implementation. XML PARSE working without
calling out to native code ensures it can be used in restricted rights environments.
Back to Top
z/Server
The z/Server configuration has been simplified through the use of a unified scheduler. This replaces the
three different types of scheduler, STC, CEA and JOB, that were used previously for starting different types
of user servers.
Back to Top
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

AppMaster Builder
CICS Support
Compatibility AddPack
Compiler
Documentation
Enterprise Server
File Handling
IDE
IMS Support
JCL Support
JES-enabled Enterprise Server Regions
Micro Focus Batch Scheduler Integration
Micro Focus Directory Server
OpenESQL
PL/I Support
Reserved words
SQL: HCO for SQL Server
HCO for DB2 LUW

AppMaster Builder
Back to the list
•

A new parm "STS" can be passed into the Program Generator. This parm tells the Program Painter to
issue an error when it encounters a STUB keyword and the stub program is not specified in the
application definition. This new parm is specified in the ISPSLIB\SSMPCOM file tailoring skeleton. Do a
search for "STUBSCAN" to see where this parm is specified. By default, this new option is not in effect.
To turn it on uncomment the line where the value is set to "YES". This feature is only available when
generating programs via the IDE. When using the Distributed Generation Server (DGS) this setting is
ignored.
2988372 (1108572)

CICS Support
Back to the list
•

The value specified in the LENGTH field of the SEND TEXT command is now honored when the target
terminal has its SOSI or PS attributes switched on. This means that trailing spaces will no longer be
removed for SOSI/PS terminals.
2884877 (1107983)

Compatibility AddPack for Visual COBOL
Back to the list
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Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.
The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Enterprise Developer for Visual Studio.
The run-time components are installed as part of Enterprise Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.
The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.
Compiler
Back to the list
•

Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.
2869185 (1105763)

Documentation
Back to the list
•

There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server
Back to the list
•

WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.
2989188 (1108602)

IDE
Back to the list
•

•

You can now open data files in RSE configured remote projects using the mfdatatools2 on the remote
machine displaying back to an X display. You can configure the remote tools display by clicking Window
> Preferences > Micro Focus > X Display. In the X Display (DISPLAY) field, type the display details. In
addition, COBOL Explorer displays the Open With Remote Data File Editor context menu item for
remote data files.
2852872 (1104085)
Enterprise Server sign on credentials which were created on Windows when using the 32-bit versions of
Enterprise Developer or Visual COBOL for Eclipse are not compatible with the 64-bit versions of those
products, and vice versa. Users are required to re-enter credentials which are not compatible with the
current version of the product. You only need to do this the first time they are used in the current
product.
(625819)

File Handling
Back to the list
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•

Under certain circumstances, retry-lock requests on UNIX systems were sleeping for a second before
re-attempting to acquire the lock. This no longer happens.

•

2988222 (1108521)
A problem that generated a 39 error when attempting to access a VSAM file via an alternate index
PATH element has been fixed.

•

2874622 (1106562)
Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a
file status of 35 is returned, regardless of the access mode specified.
2692826 (1093604)

•

New PARM option SIGN-EBCDIC documented for MFJSORT.

•

2880037 (1107256)
The MFJSORT ICETOOL emulation now supports the USING parameter in the SELECT operator.

•

2821176 (1099529)
An empty, space-filler record is no longer produced at the end of an ICETOOL listing file.
(622789)

IMS Support
Back to the list
•

Inconsistent results returned to a GET call issued from a PROCOPT=GO application when segments
within the same database record were updated and locked by another session. Symptoms included an
invalid (GE) status code or the wrong segment returned to a GN call. This has been fixed.
2862879 (1104899)

•

The IMS control page is now secured according to the IMS* entity in MFESMAC.
2877405 (1107099)

JCL Support
Back to the list
•

•

•

•

An emulation of the LE run-time option CBLQDA has been implemented in the form of the environment
variable MF_CBLQDA. The default is OFF, but when set ON, QSAM files can be dynamically created.
3104665 (1109251)
A new event call to the JCL user exit (MFJUXIT) has been included. The event 'job-queued' (event code
27) occurs when a JCL job has been parsed and put on either the Input Ready queue or the Input Hold
queue.
2990395 (1108734)
When reading commands, MFFTP now checks the charset (EBCDIC or ASCII) of each concatenated
INPUT dataset to determine if it should be translated. The output is written in the charset which
appropriate for the dataset.
2876407 (1106795)
The PHYSFILE security setting will now be checked when a dataset entry is inserted into the catalog, or
when a dynamic PDS member is created.
2857819 (1104844)

JES-enabled Enterprise Server Regions
Back to the list
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Important: Existing JES-enabled Enterprise Server regions must perform this upgrade to continue
using JES functionality. If you start a region without upgrading, the following message is displayed in
the console log, and JES functionality is disabled:
JES000058E JES validation - Product requires new spool control files. Run
spool conversion utility, splconv, to create them.
In this release, the infrastructure of the JES spool repository has been upgraded in order to improve
performance (see the Enterprise Server section of What's New for more details). For each JES-enabled
region, before you can submit any jobs to JES, you must run the spool conversion utility; any newly created
regions will automatically be configured to use the new spool files.
The conversion process converts the information in the existing spool files to a set of new files required
under the new system. There should be no loss of data in moving to the new system.
Important: After converting to the new JES spool infrastructure, we recommend that you do not
employ the increased range of job numbers until you have thoroughly tested the new infrastructure.
Reverting back to the previous JES spool files is possible, but requires that you remove all job entries
using more than 5 digits, for which there is no easy process.
To run the spool conversion utility
1. At the Enterprise Developer command prompt, set the following environment variables, as required:
Variable

Description

MFSYSCAT

The location and name of the current JES catalog. This
is mandatory.
If multiple catalog files are being used (that is, one or
more user catalogs are defined), this environment
variable should point to the catalog where JES spool
datasets are cataloged.

MVSSPOOLDIR

The location of the current JES spool files. This is only
mandatory if the location is different to the location of
the JES catalog.

NEWSPOOLDIR

The location for the resulting JES spool files (that is, the
SPL* files if running the conversion, or the old-style
spool files if running the regression). This is only
mandatory if the location is to be different to the location
of the existing spool files.

MFSYSCAT_ERRS

The number of catalog errors that will be tolerated
during the conversion process before the conversion is
terminated. This is optional, and defaults to 100.
If the process is terminated, the following error is
produced:
MVSCATIO Error limit exceeded = nnnn
(where nnnn is the error count)

2. Type splconv, then press Enter.
The conversion process runs, and details of the files and records converted are displayed to screen.
3. If MVSSPOOLDIR and NEWSPOOLDIR were set to different locations prior to running the conversion,
you must now set MVSSPOOLDIR to the value of NEWSPOOLDIR.
Note: If you do not perform this step, you will receive the following error when you start your
region, and JES fails to initialize:
JES000058E JES validation - Product requires new spool control files. Run spool conversion utility,
splconv, to create them.
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4. You can now start the region identified by the variables, and begin to submit jobs.
Reverting to the previous JES spool repository
If you plan to downgrade to an older version of your current product, any enterprise server region that has
been converted or created with the current product will not be compatible. Before you can use them, they
must be reverted to using the old JES spool repository.
Use this process if you are wanting to use a JES-enabled region in a previous version of the product:
1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.
2. Set an additional variable, SPLREGR_TARGET, to PRE30.
3. If the region has started to use 6- or 7-digit job numbers (an enhancement new to version 3.0 of the
product), then before you run the regression, you must remove the jobs that are using these numbers,
and ensure that the MF_MVSJOB environment variable (or the SPLJNO.dat file if the variable is not
used) does not specify an upper limit greater than 5 digits.
Note: If using the MF_MVSJOB environment variable, to revert to 5-digit job number support, set
MF_MVSJOB=<low number>+<high number>, where high number is less than 0099999, and
ensuring that the + sign is used to separate the low and high values.
4. Type splregr, then press Enter.
The regression process runs, and details of the files and records converted are displayed to screen.
You can now use the region identified by the variables in previous versions of Enterprise Developer.
Exporting the spool files to Enterprise Server for .NET
If you plan to export a region to Enterprise Server for .NET, any enterprise server region that has been
converted or created with the current product will not be compatible. Before you can use them, they must
be reverted to using the old JES spool repository.
Use this process if you are exporting a JES-enabled region to Enterprise Server for .NET:
1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.
2. Set an additional variable, SPLREGR_TARGET, to the appropriate value:
DOTNET5
Create spool files for use on Enterprise Server for .NET, using a maximum of 5 digits for
job numbers.
DOTNET7
Create spool files for use on Enterprise Server for .NET, using a maximum of 7 digits for
job numbers.
3. Type splregr, then press Enter.
The regression process runs, and details of the files and records converted are displayed to screen.
You can now use the region identified by the variables in Enterprise Server for .NET.
Micro Focus Batch Scheduler Integration
Back to the list
•

MFBSI no more requires that the name of the last folder specified in the path in MFBSI_DIR matches
the name of the target Enterprise Server region. It is now possible to specify any directory path in
MFBSI_DIR. You must use the same value for MFBSI_DIR in both the Enterprise Server configuration
and for MFBSIJCL execution. When the name of the last folder specified in the path in MFBSI_DIR
does not match the name of the target Enterprise Server region, you need to specify the region name in
one of the following ways: 1. From the mfbsijcl command line, using the parameter
REGION=ESRegionName. 2. In an MFBSI configuration file, in a line containing
REGION=ESRegionName. You can specify this either in the default configuration file, mfbsi.cfg located
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using the path specified by MFBSI_DIR, or using a custom location or configuration file and the
following parameter: CFG=[path]/name[.ext] See your product help for more details.
2869805 (1105939)
Micro Focus Directory Server
Back to the list
•

•

In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.
3101625 (1109025)
Some additional CSRF security measures have been added to the Enterprise Server Administration
HTML GUI.
3101205 (1108916)

OpenESQL
Back to the list
The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for ODBC
(DBMAN=ODBC). This ensures that embedded SQL cursors that use WITH HOLD and FOR UPDATE
clauses have the same data integrity across all databases.
If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.
PL/I Support
Back to the list
•

•

PUT output-items of type POINTER are now output as a hexadecimal string rather than a fixed bin
integer value.
(623184)
Enterprise Developer 3.0 includes some changes that result in a significant performance improvement
when assigning a null character string '' to arithmetic data items, pointers, and structures. In versions of
the product earlier than 3.0, pointer = ''; assigned the value sysnull(). This has been fixed and null() is
now assigned. See the product help for details about the -setnull compiler option.
(627517)

•

Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.
2871278 (1106114)

Reserved words
Back to the list
•

There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:
ALLOCATE
FREE
JSON
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END-JSON
SQL: HCO for SQL Server
Back to the list
•

The HCOSS Assess Application Migration tool now enables you to view the original DB2 SQL and the
converted TSQL together in both the HCOSS tool itself and in any exported CSV files.

HCO for DB2 LUW
Back to the list
•

Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) UIs have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.

Significant Changes in Behavior or Usage

| 21

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•
•
•
•
•
•

Debugging
Enterprise Server
Eclipse
Micro Focus Rumba
Resource Adapters
REST/JSON IMTK implementation and the same-origin policy (SOP)

Debugging
•

When debugging .gnt code on early builds of Windows 10 and Windows Server 2016, execution fails
to stop at COBOL breakpoints. To resolve this, you should install the most recent Windows updates for
your operating system, as this problem is only known to be present with the earlier versions.

•

When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

•

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.
Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:
1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

•

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
<DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>
3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.
4. Start Eclipse from the same command or shell prompt.
Remote debugging does not work for programs running on AIX or HP machines, if you are trying to
debug using Enterprise Developer installed on a Linux machine.

Enterprise Server
•
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On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Eclipse
•

If you are upgrading your license from Enterprise Developer for Eclipse Personal Edition (v2.2 or earlier)
to Enterprise Developer, or from Enterprise Developer Connect (v2.2.1 or later) to Enterprise
Developer, any existing projects compiled to either .exe or .dll files using the old license must be
updated in order to recreate the .cobolBuild file. You can do this done by adding or removing files
from the project or by deleting the .cobolBuild file. Updating the project in this way ensures Eclipse
will fully build the executable files.

•

Opening a COBOL or a PL/I project in Enterprise Developer modifies the .cobolProj and .pliProj
files. Once modified the .cobolProj and .pliProj files are no longer backward compatible with
older versions of Enterprise Developer. This prevents you from opening the same projects in earlier
versions of Enterprise Developer.
Note: Micro Focus recommend that you backup your .cobolProj and .pliProj files before
opening projects created in earlier versions of Enterprise Developer.

Micro Focus Rumba
•

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

Resource Adapters
•

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)
•

HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Application Workflow Manager
AppMaster Builder
Assembler Support
Character Animator
CICS Support
COBOL to XML Schema generation
Codeset Support
Common Communications Interface
Communications Server
Compiler
Data Tools
Debugger
Documentation
Editor Writing Assistance
Embedded HTML Pre-Processor
Enterprise Server
File Handling
HCO for DB2 LUW
HCO for SQL Server
IBM Language Environment for OS/390 & VM Support
IDE
IMS Support
Interface Mapping Toolkit
JCL Support
Mainframe Access
Micro Focus Batch Scheduler Integration
Micro Focus Directory Server
Monitoring and Management
OLE Class Library
OpenSSL
PL/I Support
REX Support
RM/COBOL
Run-Time System
SQL: COBSQL
SQL: OpenESQL
SQL Option for DB2
XML Support
z/Server

Adis
Back to the list
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•

PIC N items are now filled with double-byte space when required by ADISCTRL options 15 and 16.
2913183 (1108448)

Application Workflow Manager
Back to the list
•

AWM tree tables now show element properties of non leaf elements.

•

2875325 (1106680)
A new "Show Progress Monitor" model attribute for action descriptors is now available. It allows you to
control whether a progress monitor dialog is displayed while an action is being executed.

•

2611122 (1087640)
Improved AWM performance with large element lists.
Affected resource contexts are now persistent and keep the output parameters received from other
tools. This functionality must be enabled manually in older models from the application options.
Model enabled conditions now use returned tool output parameters if available.

•

2879746 (1107245)
Sub-menus are now created for modeled AWM Global Editor Actions.

•
•

2877404 (1106916)
AppMaster Builder
Back to the list
•

•

•

•
•

•
•

A problem with parsing short or empty lines of code to set directives in a generated COBOL program
has been fixed by updating the parser to check that each line is long enough to parse.
3105895 (1109423)
A problem in the AMB Screen Painter that prevented certain attributes from being propagated to newly
created field(s) when a field or a group of fields was Copy/Pasted into the AMB Screen Painter has
been corrected. **** Note to customers **** If an existing screen will not generate properly, the symptom
for the above issue will be a "SCRNFLD1" record (or multiple records) with missing attributes
(Protected, Color, etc.) in the APSSCRN file. The screen can be corrected by: 1) Forcing a value to be
written for the Protected attribute for each of the fields with missing attributes. OR 2) After applying this
release, delete and then recreate the fields with missing attributes.
3105513 (1109365)
A problem with generating just filtered items instead of all screens and programs of an application has
been fixed.
2883198 (1107718)
Generating all Online Express programs no longer generate other non Online Express programs.
2881296 (1107444)
A problem using the Tab key to move the cursor from one control to another in the AppMaster Builder
Editor caused code generation failure. This has been fixed by changing the behavior as follows: o 'Tab'
character has been replaced with space/blank character(s). o When pressing the 'Tab' key in a Keyword
area, the cursor moves to the Painter's statement area. o When pressing 'Tab' key in statement area,
the 'Tab' character is replaced by spaces, where the number of spaces is determined by the tab size in
set in preferences, which is usually 4.
2865685 (1105222)
The APRPROG member is now renamed correctly.
2865681 (1105215)
The generation process now performs a search for empty files or files that do not exist and displays an
appropriate message in the console. If a file is empty or does not exist, it is now denoted with a special
icon in the tree view.
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•

2849461 (1103620)
When executing "Generate All Programs" or "Generate All Screens", programs or screens located on
the Mainframe were being skipped. This issue has now been fixed.
2849347 (1106274)

•

•
•

•

A new preference has been added to allow you to delete generated screen symbols in Project Explorer.
By default, the option is not enabled. To enable the deletion of generated screen symbols, click Window
> Preferences > Micro Focus > AppMaster Builder > Customization, and then click "Also delete
generated screen symbols".
2877731 (1106958)
Failure to delete the APSEXPS program has now been fixed.
2877730 (1106960)
The new APSPROG and APRPROG members are now copied from the appropriate source members.
The APSEXPS member now has its A2XP1 record content updated to reflect the new name.
2872848 (1106353)
Program generation sometimes wrote incorrect subselect qualifications. This has been corrected.
2869807 (1105876)

•

A problem in the Screen Painter that prevented a Static Text field from resizing properly when also
dragged to the left has been fixed. In addition, the Attributes dialog box has been updated to no loger
restrict the Text Value to the initial Length, enabling users to change both the Lengh and Column values
from the Attributes dialog box.
2880744 (1107412)

•

A problem with the "M" icon disappearing from the APSSCRN display when mainframe source is used
has been fixed.
2884715 (1107998)

•

The Find Object in Application dialog box has been updated to default to the Program object type
instead of the Data Structure object type.

•

3107789 (1109560)
A problem that caused application properties to display incorrectly has been fixed.

•

3102332 (1109525)
A problem that caused AMB Drag and Drop to create duplicate lines has been fixed.

•

3102010 (1109008)
The Program Painter and Report Painter utilities now provide an optional cross-hair cursor that has
customizable line color and line size options.

•

2988615 (1109536)
Copy+Add has been updated to populate the list with the selected program and focus on the New Name
field.

•

2887075 (1108337)
Generated IMS programs that contain EXEC DLI calls now set the EXECDLI directive set when adding
the programs to a COBOL project.

•
•

2886955 (1108743)
The Add dialog box has been updated to support filtering.
2886718 (1108233)
A problem that caused the Project Explorer to display AMB application names non-alphabetically has
been fixed.
2885980 (1108714)
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•

A problem that caused the Rename dialog box to activate improperly has been fixed.

•

2885393 (1108062)
A problem that caused a lag in screen updates when receiving input from the keyboard has been fixed.

•

2885249 (1108033)
Preferences for the AMB Editor have been updated to enable users to specify a background color
preference.

•

2885248 (1108031)
AMB Editor preferences have been updated to enable the setting of an alternative foreground color that
enables text to be visible when the background color is changed.

•

2885248 (1109495)
A problem that sometimes caused inaccurate program attributes to display after startup and when the
application was expanded has been fixed.

•

2884923 (1107996)
The Copy+Add feature has been updated to allow filtered text to be entered before clicking Load.

•

2883952 (1107863)
A problem with the Filter option not appearing on the context menu when an application node was not
expanded has been fixed.

•

2883202 (1107716)
The User Interface has been updated to allow the filtering of different program types such as Online
Express and Program Painter.

•

2883199 (1107719)
To improve the application loading process and speed, AMB now refreshes application items in the
background and also issues messages that report loading progress.

•

2881334 (1107522)
An error in setting the local path for mainframe batch programs caused those programs to be
inaccessible from the AMB COBOL Editor. This has been fixed.

•

2879146 (1107360)
A problem with using the keyboard to enter a colon character (:) has been corrected.

•

2878322 (1107030)
A problem with the Job Queue delete tool appearing in incorrect views and/or perspectives when set to
float has been fixed.

•

2877735 (1106975)
When an APSAPPL member contained less than 71 characters on a line, it was not being properly
read, sometimes causing GLOBAL items to be blank. This has been fixed.

•

2875467 (1106713)
A problem with the 'Unnumber' editor command deleting codes has been fixed.

•

2867293 (1105487)
A problem that caused the AMB Editor to freeze has been fixed.

•

•
•

2867151 (1106095)
A problem with extraneous exception error messages appearing in the Eclipse error log has been fixed.
In addition, you can now specify the location of USERVARS on the Environment preference page.
2865822 (1105473)
A problem with the AMB Editor that caused it to lock up when tabbing backwards has been fixed.
2865685 (1107162)
A problem with the COBOL project name appearing incorrect on the Application Preferences page has
been fixed.
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•

2865309 (1105141)
A problem with the 'Change Project' menu not appearing has been fixed.

•

2862013 (1104784)
A problem with the creation of a new APRAPPL member when editing an item of the program has been
fixed.

•

2857813 (1105793)
A problem that prevented moving or reordering members from the AppMaster Builder perspective has
been fixed.

•
•
•
•
•

2819557 (1099269)
A problem with the AMB Editor shifting characters when the Delete key was pressed has been fixed.
A problem preventing the Program Painter from working properly when the ENTER key was pressed
has been fixed.
A problem preventing the Program Painter from working properly when the ENTER key was pressed
has been fixed.
A problem that prevented the proper insertion of a new line in the numeric area when pressing the
ENTER key has been fixed to insert a new line with the caret in beginning of the statement area.
The Application Edit feature has been updated with validation logic to verify paragraph, subprogram,
and macro names.

Assembler Support
Back to the list
•

•

•

To provide EBCDIC to ASCII conversion, the Assembler directive ASCII has been added to generate all
character literals in ASCII instead of the default EBCDIC. For example: DC C'1' generates a hex 31
value instead of hex F1 when the ASCII directive is used.
2913358 (1108467)
The copying of PDS files in Assembler is now supported. The assembler file handler now emulates
mainframe behaviour for opening/reading/writing/closing PDSs. This allows assembler programs to
open a PDS with these DCB settings: DCB=(DSORG=PO,RECFM=FB,LRECL=80,BLKSIZE=0) for both
input and output and copy a PDS with a simple read/write loop as on the mainframe.
2881923 (1108596)
SVC 8 (LOAD) now sets the high order bit of the loaded module address as per the AMODE of the
loaded assembler module. If the module loaded has been linked AMODE(31) then the high order bit is
set in the returned address so it matches IBM mainframe behaviour.
2880278 (1107639)

CICS Support
Back to the list
•

•

•

An issue causing a Communications Server failure during Cluster SEP recovery processing has been
fixed.
2883390 (1107785)
A timeout on a global lock request for a CICS dataset, caused by the GLM not responding, could
generate an RTS 114 on dfh0msg in the requesting Cluster Slave.
2880992 (1107401)
An issue with the _NOCONVERT option of CICS SEND FROM statements when a LU1 printer is used
as an output has been resolved. The control characters of the 3270 data stream are not meaningful to a
LU1 printer, and are no longer sent in such scenarios.
2877807 (1106961)
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•

•

Support has been added for the extended form of RECEIVE_ALLOCATE, "RECEIVE_ALLOCATE_EX",
to specify the alias of the local LU from which the TP will accept incoming attaches (IBM
Communication Manager only).
2877178 (1106980)
A 64 bit CRTE or transaction routing request from IBM CICS mainframe to Micro Focus Enterprise
Server CICS now correctly returns the expected data.
2876499 (1106860)

•

Programs that contain non-unique variables on a CICS command now produce a more specific error
message (COBEC1125 : Operand {operandName} is not unique) when compiled in an IDE.
2865273 (1105126)

•

Terminating a SEP that is being waited on by another SEP no longer causes a corruption in the JCP/TD
return chain in the shared memory.

•

3107347 (1109532)
An problem that caused a TASKIDERR to be returned on EXEC CICS INQUIRE TASK when the task
was greater than 9999999 has now been fixed.

•

3101286 (1109036)
A problem has been fixed that caused INQUIRE Terminal to return TERMIDERR when the terminal had
been installed from a resource definition and the terminal did not have a termtype.

•

2912829 (1108576)
A problem with the CASTSC system module crashing when a START with data was executed during
region initialization has been resolved.

•
•

2886905 (1108257)
An ASSIGN INVOKINGPROG in an XCTLed program now shows the correct program name.
2885264 (1108071)
A problem that caused EXEC CICS SET FILE CLOSE statements to return an invalid request error
when the file was modified in the current task has been fixed.
2870461 (1106061)

•

•

•

•

A problem with ESMAC display fields that enabled Authorization bypass and caused XSS-related issues
has been fixed.
3101205 (1108918)
A problem in ESMAC that prevented TERM from accessing the related SYSC and SYS6 pages has
been fixed.
2881359 (1108307)
The ESMAC > Clients page has been updated with a new Stop button that enables you to stop active
printers. In addition, you can now modify predefined printer terminal attributes and reinstall a printer
terminal.
2874807 (1106608)
The Users button was sometimes unavailable in ESMAC. This has been fixed.
2860762 (1104487)

•

CICS support has been updated to support the MQSUB API.
2878763 (1107270)

Character Animator
Back to the list
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•

The Break>Cancel-All option no longer occasionally freezes the Animator.
2879817 (1107460)

COBOL to XML Schema generation
Back to the list
•

CBL2XML now handles namespace correctly.

•

2861655 (1104748)
CBL2XML now correctly handles non-default type within <restriction>.
2826345 (1100279)

Codeset Support
Back to the list
•

The Codeset DBCS tables MFTR0886.A2E MFTR0886.E2A have been updated to match the latest IBM
Traditional Chinese conversion tables below: Description of 9027: T-Ch Host Double-Byte including
6204 UDC including euro. Description of 21427: T-Ch DBCS-PC (IBM BIG-5) including 13493 CNS, 566
IBM selected, 6204 UDC & euro.
3104948 (1109314)

Common Communications Interface
Back to the list
•

•

Using CCI shared memory and receiving data with a max receive length less than the total amount of
data received resulted in the data being received incorrectly on the final receive. This has now been
fixed.
After a communications failure, Enterprise Server shared-memory listeners would sometimes stop
accepting new connections. This has now been fixed.

Communications Server
Back to the list
•

A path-traversal vulnerability has been fixed in the mfcs-esfadmin optional component of Enterprise
Server. This vulnerability could allow a user with network access to a suitably-configured Enterprise
Server region to download unauthorized files from the target system.

•

3101205 (1108925)
In Enterprise Server, chunked HTTP requests now work with CICS Web Interface and CICS Web
Services servers.

•

3100279 (1108857)
Persistent J2EE sessions to Enterprise Server could hang under heavy load, resulting in accumulating
idle transient SEP processes. This has been fixed.

•

2884386 (1108206)
Enterprise Server's communications server (MFCS) no longer crashes in certain error-handling
situations, such as when sufficient memory cannot be allocated to handle an extremely large HTTP
response message.

•

2881711 (1107546)
Enterprise Server now correctly enforces the order of responses to each client.

•

2874420 (1107167)
An issue causing intermittent MFCS crashes at start-up due to heap corruption has been fixed.
2866204 (1105983)
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| Resolved Issues

•

•
•
•

TN3270 conversations no longer hang, looping in the MFCS process, if the client sends a malformed
TN3270E header. A message will now be written to the MFCS log and the input record will be
discarded.
An error handling bug in the MFCS Fileshare connector, which could cause a thread-termination error,
has been fixed.
In some cases, MFCS could hang or crash some time after multiple threads abended within a 60second period. This has been corrected.
HTTP path-traversal vulnerabilities, which could lead to information exposure, have been corrected in
Enterprise Server's MFCS component.

Compiler
Back to the list
•

•

•
•

•

•
•

Level-88 VALUE clauses that inadvertently contain fixed point numeric literals, which cannot be
matched with the associated numeric type, are now flagged with an E-level message.
3106909 (1109479)
A new ARITH"COMPAT|EXTEND" Compiler directive is now supported to emulate the IBM mainframe
option of the same name. This option defines the maximum number of digits for numeric data items.
3105597 (1109340)
An extended ACCEPT of a PIC N data item now compiles successfully, as expected.
3101615 (1108944)
The reference to an ASSIGN name in the SELECT clause is now included in the IDE's 'Find All
References' list irrespective of whether the ASSIGN name is explicitly declared later in the source or
not.
3100084 (1108817)
When an intrinsic function is used as a parameter to an inline method invoke, which is also a parameter
to another inline method invoke, the Compiler would produce invalid code, leading to a COBRT200
error. This is now fixed.
2991106 (1108786)
Prototype checking for OMITTED parameters in inline method invokes is now working as expected.
2991031 (1108800)
An error when an OBJECT PROPERTY is used in subscript calculation, or reference modification index
or length calculation, has been fixed.

•

2990388 (1108738)
A directives file with an explicit end of file character is now processed correctly.

•

2913115 (1108474)
A DISPLAY of ADDRESS OF <data item> now executes as expected.

•

2913005 (1108635)
Prototype checking for nested inline method invokes is now working as expected.

•

2912463 (1108437)
A bug where compilation of very large managed projects could fail with error "COBCH1500: memory
allocation failure – module 'allocmem'" has been fixed.

•

2886156 (1108156)
Using COBSQL with CP for a program with complex multi-line COPY REPLACING no longer results in
spurious errors.

•

2884493 (1107939)
A move from a group to a reference modified PIC N field now executes as expected.
2884093 (1107883)
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•

•

•

Producing a test coverage report in Eclipse no longer gives an exception for SQL programs with ENTRY
statements.
2882106 (1107558)
Sign-included numeric usage DISPLAY items now display as expected under a mainframe dialect; that
is, they display with the included sign shown exactly as stored, without conversion for readability.
2879364 (1107340)
The use of N" national literals in STRING statements no longer produces incorrect results.

•

2878504 (1107053)
A bug where COBDATA was set prior to starting the Visual Studio IDE, and was then blank when
applications were executed, has been fixed.

•

2878431 (1107160)
A user class condition where the subject has the potential to be zero length now compiles and executes
as expected when compiled with a mainframe dialect (which sets the ZEROLENGTHFALSE directive).

•

2878426 (1107044)
The same names used for data items in both method local and object storage could sometimes result in
wrong execution results when the wrong duplicated name was used.

•

2878370 (1107207)
Class conditions defined in the SPECIAL-NAMES paragraph now work when SELECT statements are
defined before the SPECIAL-NAMES paragraph.

•

2876808 (1106853)
Under CHARSET(EBCDIC), a MOVE of PIC G/N data items to PIC N/G data items now pad with
x"4040" (an EBCDIC DBCS space). Comparisons of such data items will now also work correctly.

•

2876109 (1106752)
VALUE clauses with hex literals now pad correctly with x"40" under CHARSET(EBCDIC).

•

2875748 (1106704)
Statements involving properties and 'OCCURS DEPENDING ON' tables now compile and execute as
expected.

•

2875074 (1106626)
Concatenation of alphanumeric literals in a VALUE clause for a national item is now treated as
intended.

•
•

•

2873871 (1106451)
Queries of reference modified national data items now work as expected.
2873639 (1106443)
Using INSPECT <national-data-item> with the BY SPACE clause now works as expected. When dealing
with national data items, SPACE is now treated as a national space - NX"0020£.
2873388 (1106390)
A user class condition test, where the item being tested is a reference modified item with a length that is
an expression, and when the directive ARITHMETIC(OSVS) is set, no longer causes an internal error
on compilation.

•

2873219 (1106409)
Nested inline method invokes now work as expected.

•

2872741 (1106315)
A MOVE statement referencing a property name now compiles and executes as expected.

•

2872488 (1106304)
A program containing DBCS characters in the sequence area of an otherwise blank line now compiles
correctly and without error.
2868802 (1105699)
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| Resolved Issues

•

An issue with using DECLARATIVES without a USE statement has been fixed.

•

2867168 (1105446)
If more than one report shared the same FD, for example: REPORTS ARE REPORT-1 REPORT-2. then
under HOSTRW, the record length was wrong. This has been corrected.

•

2865849 (1105553)
The use of the HOSTRW and CURRENT-DATE directives no longer causes an excessive number of
lines in a report produced from the Report Writer.

•

•
•
•

•
•

•
•

•
•

•

2853789 (1105472)
A USE FOR DEBUGGING statement that references a table item and is triggered by a condition where
the table item is referenced but not evaluated (due to short-circuit evaluation) now executes as
expected.
2433731 (1073167)
A bug in the Compiler, when REPLACE is used and the final line in the main source file is a copy
statement containing a separate program, has been fixed.
An error reporting the size of return-code by the Eclipse IDE has been fixed.
A bug has been fixed in programs compiled with CHECKDIV"OSVS" that contain a statement of the
form: COMPUTE r = a / (b - b)
3105637 (1109410)
A bug in ON SIZE ERROR for arithmetic statements using floating point variables has been fixed.
2886077 (1108151)
A bug has been fixed in generated code on Linux/390 for statements of the form: compute rounded a =
b / constant where a and b are both comp-3 variables, and constant is an integral power of 10 (e.g. 10,
100, 1000).
2874143 (1106479)
A COBRT114 error that was occurring at run time in generated code has been fixed.
2871410 (1106100)
An error in debugging on Intel 32-bit platforms, such that a breakpoint set on an "exit method" statement
is ignored if it immediately follows a statement such as "end-perform", "end-if" or "end-evaluate", has
been fixed.
2861424 (1104587)
A bug in generated code with the opt(3) directive, on Intel x86 64 bit (Linux and Windows) and
Linux/390 has been fixed.
For programs compiled with JVMGEN, the directive HOSTFD is not currently supported, and is
switched off by the Compiler. However, for programs compiled using the ILSOURCE directive, this
switching off did not happen, and as a consequence, bad code was generated that led to exceptions at
run time - this has now been fixed.
3103829 (1109174)
Debugging is now working correctly for JVM COBOL programs where the PROCEDURE DIVISION
spans more than 65535 lines.
3102742 (1109264)

Data Tools
Back to the list
•

Vision and RM files that contain a null (0x00) byte in the key now function correctly in the Data File
Editor.
2882159 (1107598)
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•

The following minor enhancements have been made to the Data File Editor: - Previous filter conditions
are now remembered for each file when the dialog is loaded. - The default filter operator now defaults to
'Contains'. - Field attributes for reference conditions now default to 1:max-rec- length, instead of 1:1.
2878521 (1107104)

Debugger
Back to the list
•

Querying DBCS items in Character Animator now works as expected.

•

3107408 (1109521)
The debugger no longer hangs when debugging remote Enterprise Server regions.

•

2882367 (1107659)
Examining the value of large data items in 64-bit applications or when debugging remote applications
no longer causes the debugger to exit.

•

2872732 (1106322)
When debugging a remote COBOL program on Linux from Eclipse, you no longer encounter a spurious
RT 115 Signal 5 fault.

•

•

2852872 (1105048)
When debugging .gnt code, execution fails to stop at COBOL breakpoints. To resolve this, you should
install the most recent Windows updates for your operating system, as this problem is only known to be
present with early Windows builds of both Windows 10 and Windows Server 2016.
COBOL JVM programs consisting of more than 65534 total lines can now be debugged in Eclipse
provided that the total number of lines after the first line of PROCEDURE DIVISION code is less than
65535 lines.
2885726 (1108172)

Documentation
Back to the list
•

A new error message, STA0011E, has been added to the zServer Messages and Diagnostics.

•

3109473 (1109751)
The product documentation has been updated to include information and syntax for secure access to
MFDS (mfds /b).

•
•

2854625 (1103606)
Documentation for environment variables has been improved.
The product documentation has been updated to include the MFA_INDEX_FORMAT environment
variable used in configuring the Enterprise Server.
2278928 (1066511)

•

The casstart /w parameter prevents the casstart process from exiting until the region has either started
or failed to start correctly.
2868898 (1105712)

•

A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes
2989911 (1108665)
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•

The Enterprise Server documentation no longer includes the PL/I programming guide as it includes
information about editing, compiling and debugging PL/I programs which are not under in Enterprise
Server.

•

2877789 (1107019)
Additional information on the Web Services and J2EE conversation type has been added to the
"Configuring Listener Conversation Types" chapter in the product documentation.

•

2877270 (1106896)
The product documentation has been updated to include information on converting the input file used by
casrdtup from EBCIDIC to ASCI.

•
•
•

2863611 (1104940)
The documentation for bit zero of the 'thread-state' parameter of CBL_THREAD_LIST_START and
CBL_THREAD_LIST_NEXT has been corrected.
Documentation of CBL_LOCATE_FILE parameter corrected.
The installation instructions included incorrect information about users having to stop and uninstall an
existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service (on Windows) or a
process (on UNIX) from an existing product. This has been removed from the product help.
2877431 (1106934)

Editor Writing Assistance
Back to the list
•

IntelliSense and Content Assist now provide the appropriate suggestions after a CONTAINS expression.

Enterprise Server
Back to the list
•

An issue where SOAP elements were not mapped to COBOL code has been resolved.

•

3106199 (1109416)
When SOAP headers were part of the SOAP request, you no longer receive a "SOAP header
malformed" response.

•

3105803 (1109367)
An issue where a handler program in the pipeline caused issues with JSON GET/DELETE/HEAD
requests has been fixed.

•

•

•

•

3104977 (1109274)
An UNDEFINED_ELEMENT error message occurred when a JSON message (under CICS WEB
SERVICES) did not include an object that was present as a "record 1" item in the wsbind or the jsbind
files.
3102943 (1109085)
When a CICS Web Service was invoked with no port in the URI, the default port for the scheme was not
set up.
3100280 (1108870)
EXEC CICS SEND and CONVERSE commands now send all user-written headers (EXEC CICS
WRITE HTTPHEADER) even if the user provided values that contain null bytes. When browsing
headers with EXEC CICS WEB READNEXT HTTPHEADER, CICS will now initialize the buffers that
were supplied for the header name and value.
2990561 (1108733)
A problem where a system process (CASTRC) was unable to allocate any local storage and, as a
result, became unresponsive, has been resolved.
2886741 (1108236)
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•

•
•

2886407 (1108426)
An issue resulting in a Run-Time System error 205 "Invalid mainframe pointer" has been fixed.
2885280 (1108041)
TRANSFORM was failing in situations where an XMLTODATA TRANSFORM contained an XML
declaration with EBCDIC encoding.

•

2885262 (1108040)
The EZASOKET traces are now controlled by a COMMS trace flag.

•

2884491 (1108174)
Caching has been added for TS queues security checks.

•

2884070 (1108789)
Commarea overrides are now honored for non-facility transactions.

•

2884049 (1107879)
Usernamelen and passwordlen options are not mandatory on exec cics web converse and web send
(client).

•

2880669 (1107365)
Previously, using multiple CICS LINK statements (linking A to B to C and so on) could result in an RTS
error 114 in the CAS system modules.

•

2880542 (1107372)
The spool active job queue will now display any jobs that were started prior to resetting the time for DST
but that have not completed yet.

•

2879116 (1107204)
The debug file name generated when using CICS Web Services now includes the process ID and the
task number. For example - inquireCatalogClient-19556(00028)-CWS-REQUESTER.TXT.

•

•
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Casout commands running in a loop from the same process used to exhausting resources. This was
caused by an invalid path concatenation.

2878485 (1107077)
The SOAP to COBOL mapping under CICS Web services was incorrect when an optional element had
no child elements (where the schema defined a minimum of one such child element and these child
elements have been mapped to a container). In such cases, the number of instances of the child
element would have an incorrect value of 1 where it should be 0.
2877043 (1106879)
If you used XA with more than 7281 transactions or had a number of JCL jobs that used XA, a record
could be split across multiple blocks. After restarting the enterprise server, a large number of
CASXO0029I errors were reported in the console log file. A block that can hold up to 7282 records is
now used.

•

2874024 (1106469)
When casout is used to release a job, casmgr now attempts to dispatch the job immediately rather than
waiting for its next dispatch cycle which previously could take 20 seconds.

•

2873224 (1106621)
If there were more than 20 TRANCLASS instances specified in the startup list, this could cause
memory corruption.

•

2868129 (1105682)
The ESFCA0401I Cache Termination message is now available for JES, IMS DB, IMS TM, MQ, and
iFileshare processes.

•

2866750 (1105376)
A duplicate security check about whether the user has enough permissions to run a JCL job has been
removed.

| Resolved Issues

•

•

•
•

•

2866526 (1105336)
When eci-tpn is used on a call to ECI for CTG or the Micro Focus implementation of ECI, Enterprise
Server now verifies the transaction exist and is enabled. If the transaction is disabled, an abend AZI6 is
returned. This is mainframe-compatible behavior.
2863500 (1105165)
An EXEC CICS LINK to a non-CICS module now handles the data context correctly and you no longer
receive CDCD abends on any further LINKs.
2858747 (1104275)
CASxx5006I messages now display a return code.
2853609 (1103516)
All ESMAC pages are now secured. Users who are not authorized now receive an error message when
trying to access any of these pages in their browser.
2843901 (1102247)
The CICS WEB services now support SOAP 1.2.

•

2822822 (1099723)
An issue that could cause an RTS error 119 on a casout command when starting a batch initiator has
been fixed.

•

An issue with certain length DNs that could cause DNs to become truncated has now been fixed.

•

•

•

•

•

3103303 (1109366)
If nested groups (user groups containing other groups) were used with LDAP-based security for
Enterprise Server, it could result in Enterprise Server hanging at region startup, or users might not be
assigned all of their groups. This has now been fixed.
2988205 (1108935)
The "check TLQ first" option has been added to the MLDAP ESM. The option can change the Rule
processing algorithm. This option might improve performance when there are large numbers of
resources in a class.
2875051 (1106874)
Enterprise Server no longer crashes on startup if LDAP-based external security with the "all-groups"
and "redundant" options are both specified, but the "federated groups" option is not.
2874010 (1106529)
If the esfupdate utility is used to request an update of security information for a user, and that user was
originally signed onto the system using a lowercase representation of their user ID, the update now
correctly identifies and updates the user.
2871297 (1106164)
If the MFDS Security Configuration specifies that verify requests should be cached and the cache TTL
and limit values are non-zero, for example, the MF Directory Server Security configuration page
Security Facility configuration text contains: [Cache] requests=verify If a new password was specified in
a Web interface logon request, then previously it was being ignored. Previously, if the user was logging
on with an expired password and attempting to change the password the request would also be ignored
and an expired password error would be returned.
2868342 (1105626)

•

An RTS 205 error during the execution of an AMODE application could occur when Assembler address
0 was erroneously de-registered. This is now fixed.
3104561 (1109229)

•

Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.
2863222 (1104948)
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•

•

Enterprise Server listeners that are configured for TLS (also known as SSL) no longer hang if a client
connects to them without sending any data.
2873177 (1106408)
In some HotFix releases of earlier versions of Enterprise Developer and Enterprise Server, SSL or TLS
connections to an Enterprise Server could hang if client certificates were used and there was a delay of
at least several seconds before the certificate was sent.

Embedded HTML Pre-Processor
Back to the list
•

The XML run-time system did not handle data items with the OCCURS clause correctly.
3107418 (1109566)

File Handling
Back to the list
•
•

•

•

•

The ESF LDAP Security Administration Web Interface now has a logoff button.
2871551 (1106117)
CICS SYSOUT output now displaying correctly in the Classic Data Tools editor. Some recent changes
to determine whether or not in-stream data needed to be converted to/from EBCDIC were causing the
problem.
2883885 (1107847)
If data compression is specified when trying to open a fixed block file, when running under a mainframe
dialect, the File Handler now checks to see if it is trying to open a VB file. If it isn't, compression will be
turned off and the file will be opened as normal.
2870022 (1105956)
An internal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.
2868664 (1105707)
When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler
was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.
2864802 (1106106)

•

•

A CBL_FREE_MEM statement in Fileshare was missing a 'by value' clause, which was causing a runtime error. This is now fixed.
2883421 (1107767)
When running under Fileshare, a delete on a locked record no longer results in a record locked status if
the same user had previously obtained a read lock on the file.
2832909 (1108287)

•

When REBUILDing from SEQ into IND with duplicate key, you will no longer get a corrupted file if you
do not specify the target flag /t.
2880311 (1107302)
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•

CSF to ZD negative sign conversion is now handled correctly during a sort operation.

•

3103118 (1109125)
JCL SORT no longer abends if no record is rewritten to a DUMMY data set.

•

3102468 (1109052)
Sorting ESDS files to RRDS files no longer truncates the first 4 bytes of each record.

| Resolved Issues

•

•

3101385 (1109112)
Variable length SORT OUTFIL files are now created correctly when more than one data set is specified
in the targeted OUTFIL.
2881629 (1107551)
MFSORT INCLUDE will no longer include the first record in the concatenated file if, according to the
parameters, that record should be excluded; previously, the first record was included regardless of the
parameters.

•

2876259 (1106785)
For an MFJSORT, a combination of numeric tests and logical comparisons now returns the correct
records.

•

2870986 (1106216)
When copying concatenated files in MFJSORT, for sequential fixed block, the correct number of record
is now used.

•

2870506 (1106057)
MFJSort now produces the correct number of records regardless of the value of the SORTSPACE
setting.

•

2867668 (1105534)
An error when writing the ICETOOL listing from an empty input file has been corrected.
2866176 (1106459)

HCO for DB2 LUW
Back to the list
•

•

•

The HCO DCLGEN tool has been updated to generate PL/I copybooks with valid definitions for graphic
and decimal data types and to compile cleanly with the PL/I -mvs option.
3105260 (1109306)
A problem that sometimes occurred when using the DB2(NOHCO) compiler directive option caused the
return of incorrect codes at completion of program execution. This has been fixed.
3100172 (1108872)
The DB2 preprocessor has been updated with a new DB2 compiler directive option, QUALIFY-CALL,
that works with the QUALIFIER compiler directive option to qualify DB2 EXEC SQL CALL statements
with the schema name specified by the DB2 QUALIFIER directive.

•

2884948 (1108032)
The DB2 ECM has been updated to prevent an undefined ECM error when indicator variable arrays are
used in SELECT SQL statements.

•

2884605 (1107947)
The DB2 ECM preprocessor has been updated to support host variables defined as SQL TYPE IS XML
AS BLOB-FILE/CLOB-FILE/DBCLOB-FILE.
2839654 (1101707)

HCO for SQL Server
Back to the list
•

HCOSS handling of the DB2 CHAR scalar function has been enhanced for date and time conversions.

•

3103159 (1109143)
The OpenESQL preprocessor has been updated to reorder certain SQL compiler directive options to
prevent the generation of a COBES0121S error.
2883191 (1107806)
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IBM Language Environment for OS/390 & VM Support
Back to the list
•

The Language Environment (LE) utilities are now available for managed COBOL applications in both
ILGEN and ILVERIFY formats.
2843311 (1102161)

IDE
Back to the list
•

An %INCLUDE statements inside EXEC SQL blocks no longer cause the background parse to hang.

•

3106015 (1109413)
A literal inside an EXEC SQL block that contains a % symbol is processed correctly by the background
parser.

•

3105706 (1109385)
A literal inside an EXEC SQL block that contains a ':' symbol no longer causes the background parser to
hang.

•

3105705 (1109381)
Spaces that cross the right margin are trimmed on the lines that are pasted into the PL/I editor.

•

3103484 (1109156)
The JCL editor no longer reports PDS names that contain keywords as errors.

•

•

2887972 (1108594)
Background parse is no longer performed for VSE JCL programs.

•

2886880 (1108245)
Pressing the Home or End keys when Eclipse editor code blocks were collapsed resulted in the cursor
moving to an incorrect location.

•

2884211 (1107905)
Debugging source lookup performance has been improved when the "Search sub-folders" option is
used with a remote file system directory.

•

2882252 (1107658)
The format clause of the PUT statement is now supported by the background parse in the PL/I editor.

•

2882206 (1107578)
Opening a SourceConnect copybook no longer displays a Context Lost error dialog.

•

•

40

2988662 (1108553)
Include files can now be opened in the Include Dependency view either by double-clicking the include
file or by right-clicking the include file and choosing Open from the context menu.

2882175 (1107611)
The PL/I %INCLUDE statements of the form "%INCLUDE (filename );" no longer cause errors in the
editor if the filename is followed by a space character.
2881410 (1107478)
The PL/I keywords LIMITED ENTRY and ALIAS are now supported by the background parser.

•

2881035 (1107480)
PL/I variables defined using macro preprocessor facilities no longer cause error messages in the PL/I
editor.

•

2879794 (1107332)
It is now possible to successfully background parse a non-JVM COBOL program that requires use of a
preprocessor whilst using either 32-bit or 64-bit build configurations.

| Resolved Issues

•

2879008 (1107155)
PL/I variables defined using the macro preprocessor facilities no longer cause error messages in the
PL/I editor.

•

2874348 (1106612)
Lines are now wrapped in the PL/I editor after using the Find/Replace dialog.

•

2874166 (1106509)
A PL/I program opened with 'Browse' in the Team Developer view cannot be modified in the PL/I editor.

•

2874071 (1106501)
COBOL editor functions such as Go To Definition now work with programs containing REPLACE
statements that generate additional source lines.

•

2873287 (1106406)
Copybook dependencies are now shown correctly within Eclipse for 64-bit compilations.

•

2866406 (1105576)
A PL/I macro invocation used as a statement parameter is no longer reported as an error.

•

•

2862571 (1104763)
The performance of the "Updating Micro Focus model" job, user interface responsiveness and memory
consumption have been improved when folders containing large numbers of files are added to an
Eclipse project.
2856154 (1105184)
Lines are now wrapped in the COBOL editor after using the Find/Replace dialog.

•

2856003 (1103827)
The ES_SERVER environment variable is now correctly resolved when viewing the console log or
catalog in the Server Explorer view.

•

2852734 (1103371)
A problem with the core Eclipse code could cause a full project rebuild to occur when not required. This
has now been fixed.

•

2816310 (1104735)
Dependency folders can be sorted based on the order they are specified on the Build Path property
page.

IMS Support
Back to the list
•

•

•

•

Erroneous file status 46 messages appearing on the Enterprise Server system console have now been
fixed.
2886926 (1108578)
An IMS syncpoint failure that intermittently occurred at job termination, depending on the timing of
events, has now been fixed.
2877595 (1107134)
This RPI described the situation where a "GU" call using a pcb with the PROCSEQ option on a
secondary index was incorrectly returning the primary key, not the secondary index, in the pcb key
feedback area. This fix returns the secondary key or index in the key feedback area.
2877248 (1106941)
A new warning message has been added to indicate when a checkpoint call is delayed due to a
duplicate checkpoint ID. In addition, the ES_IMS_BASIC_CHKP_OPT environment variable has been
added to provide additional checkpoint optimization that enables a basic checkpoint call to process as if
a SYNC call had been issued.
2875685 (1107227)
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•

•
•

IMSLOGR file access errors that sometimes occurred on the IMSLOGR.DAT checkpoint log file when
two or more IMS BMP applications shared the file have been fixed.
2872783 (1106751)
A batch IMS program that terminates abnormally now flushes subsequent job steps in the JCL.
2864940 (1105315)
An RTS114 message was sometimes issued during the CASDBC process on a system running under a
heavy IMS DB load. This has been fixed.

•

2860205 (1106684)
The Start and Stop DB commands failed to reject non-existent DBs.

•

2857756 (1104092)
A problem with the behavior of an EXEC DLI application accessing a USERDB exit has been fixed.

•

2849576 (1102989)
A problem that prevented IMS from making the connection to the DB2 subsystem via DSNALI when
JCL is running the DNSMTV01 program, in batch mode has been fixed.
2846683 (1102634)

•

•

•

•

•

The MFS generator has been updated to issue an error message when adjacent output screen fields
are not separated by a space. To correct the problem, edit the MFS source to include a space between
the fields.
3101284 (1109215)
A new MFS compiler directive, CONTMVS, has been added to enable the compiler to parse imperfect
MFS continuation lines just as on the mainframe, meaning that when it encounters a line in the MFS
source that is continued without a terminating comma, it treats the line that follows as a comment line.
When CONTMVS is not specified, terminating commas are assumed, and the next line is treated as a
continuation of that line.
3101284 (1108961)
The MFS generator has been updated to generate the extended color attribute only when specified in
the MFS source, enabling the default colors in the PCOMM 3270 emulator to take precedence.
Regenerate MFS source after adding the extended color attribute.
2887354 (1108314)
The SYSMSG field was right-justified and this was causing a problem with displaying the output format.
The output format is now displayed correctly.
2885315 (1108134)
The printed report page is now padded with blank lines if the number of lines is less than the number of
lines per page specified in the MFS source. This only applies if the PAGE parameter is
PAGE=(n,SPACES).

•

2885281 (1108042)
An error message is now sent to the terminal if the input consists of null segments.

•

2882071 (1107587)
High-value (x'FF') bytes are no longer incorrectly removed from inbound TN3270 client data.

•

2880275 (1107581)
The trancode was being stored in a screen device field with non-modifiable extended attributes. When
resending the output screen (write command), the MDT was not being set. Input of the trancode was
not being transmitted, resulting in a DEST NOT FOUND message. To implement the fix, you must
regenerate the MFS.
2876099 (1106859)

•
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The IMS preprocessor has been updated to determine whether a job is a normal start or a restart by
looking only at the first five bytes of the checkpoint ID, as is done on the mainframe, ignoring additional

bytes if the first five are spaces. In addition, when a checkpoint ID is determined to be invalid, the
EBCDIC value of the ID is converted to ASCII before writing it to the job log.
•

3107216 (1109583)
An RTS 173 occurred at end of a job when an MQ entry point call at the end of step to clean up was
unloaded by canceling the MQ modules. This has now been fixed.

•

2872962 (1106368)
DLI status codes FD (deadlock loser) and BD (lock timeout) returned to a CICS application did not
ABEND as they should have. These status codes now properly trigger an ADCD transaction ABEND.
2864939 (1105080)

•

The IMS-TM "Trailing space" property was ineffective for EBCDIC transactions. This has been fixed.

•

2880919 (1107479)
A problem when connecting to an IMS printer that caused all pending print jobs to fail has been fixed.

•

2879885 (1107242)
When the last DLI call was a CHKP call, IMS incorrectly issued a COMMIT rather than a ROLLBACK
sync point during an ABEND of an IMS BMP. This has been fixed.

•

2877795 (1107323)
A problem that caused an External Security Manager to indiscriminately authorize an unprotected IMS
resource without regard to its "allow unknown resources" configuration setting has been fixed.

•

2877057 (1106882)
A problem with incorrectly formatted output data appearing on IMS screens when default literals or
system literals were assigned to output message fields has been fixed.
2825068 (1100049)

Interface Mapping Toolkit
Back to the list
•

•

A problem with Enterprise Server that caused an alphanumeric data item mapped to a SOAP Boolean
to give results that were incompatible with the mainframe for invalid data values has been fixed.
2887795 (1108360)
Client generation now works as expected when invoked from the Team Developer Tree View.
2869050 (1105758)

•

The performance of a COBOL Web client has been improved when processing services with interface
parameters containing unbounded arrays.
2884760 (1108026)

•

•

When a path specified as part of an ls2ws parameter contained at least one space, ls2ws would fail.
This has been fixed.
(622294)
EJB generation/deployment has been enhanced to produce an EAR file. Unlike the EAR file produced
during client generation, this deploy-time EAR does not contain a WAR file and thus does not contain
any JSP files.

JCL Support
Back to the list
•

Spool files with a status of 'Printing' are now correctly removed from ESMAC when housekeeping is run.
3108694 (1109666)
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•

An issue with the Catalog having an incorrect GDG current bias has been fixed.

•

3106790 (1109468)
Specifying DD Dummy in front of the DSN now results in the same behavior as on the mainframe.

•

3106305 (1109425)
A catalog listing of a dynamic PDS, where the PO is defined in a user catalog, will now return the
correct list of members.

•

3106260 (1109433)
Specifying DD Dummy in front of the DSN now results in the same behavior as it does on the
Mainframe.

•

3104175 (1109272)
JCL HSF - if a job step abends because a data set was not found, the resp field of the previous record
will no longer be corrupted.

•

3103184 (1109101)
A new environment variable has been introduced. Set ES_JES_PARM_INIT_LOW=Y to initialize the
parameter string passed to a program executed by JCL to low-values. The default behavior
(ES_JES_PARM_INIT=N) is to initialize the string to spaces.

•

3100700 (1109519)
A deadlock situation, when multiple dispositions were used for the same file, has been fixed.

•

3100475 (1109067)
MFJPTPCH now returns a condition code of 4 when it is run against an empty file.

•

2991029 (1108802)
A fault in the final disposition processing of a MOD,PASS dataset has been corrected.

•

2990557 (1108750)
An issue with the Catalog having the incorrect GDG current bias when concurrent jobs access the same
GDG, has been fixed.

•

2990054 (1108690)
An issue where duplicate job numbers were assigned if MF_MVSJOB had a reset value of '+' has been
fixed.

•

•
•

2988755 (1108562)
An enhancement to the loading of a JCL program means that, if there is a problem loading it, the runtime system error code will be reported. The JCLCM0193U message, PROGRAM NOT FOUND <program name>' has been changed to 'PROGRAM NOT LOADED - <program name>. RTS CODE:
<rts code>'.
2988302 (1108519)
MVSSPLHK now correctly removes the JESYSMSG for the last job in casspool.dat.
2886034 (1108308)
A new option (CLEAN-DS-FROM-ACTIVE) has been introduced to the MVSSPLHK spool housekeeping
process, which prevents removal of time-expired datasets from an active job.

•

2885734 (1108144)
MFFTP now correctly updates the sftp.cfg file with the port number specified in the JCL PARM.

•

2885618 (1108295)
The detection of the charset of command files used by MFFTP has been improved.

•

2885559 (1108081)
The failure of MFFTP to transfer an empty ESDS file from a user defined file has been corrected.
2883862 (1107878)
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•

•

•
•

•
•

•
•

The delete sweep processing of GDG has been corrected so that a new GDG dataset created in a step
is not reported as 'dataset not found' in successive steps when its older generations are deleted via
DISP=(OLD,DELETE).
2883681 (1107850)
When using IDCAMS ALTER NEWNAME for a GDG bias, a check is performed to ensure the GDG is
defined in the catalog, and if it isn't, an error message (JCLAM0241E) is generated.
2881259 (1107477)
The ASC2EBC and EBC2ASC modules are now included in the MFFTP module.
2880401 (1107321)
A file not found error resulted when using a PDSM for SYSUT1 in an MFJPTPCH step. This has now
been fixed.
2879536 (1107203)
An RTS114 error in IDAMJRM, when using MFFTP, has been corrected.
2879453 (1107607)
An issue where duplicate job numbers were assigned if MF_MVSJOB had a reset value of '+' has been
fixed.
2875286 (1106770)
Adding a new dataset no longer results an error in the ESMAC catalog listing (error code 9904).
2874557 (1106582)
When a JCL process was forcibly killed, an ENQ on SYSZJOBD could be left preventing other jobs of
the same name from running.

•

2872077 (1106506)
Previously, setting a BLKSIZE of zero resulted in a catalog entry with a BLKSIZE set to 65535.

•

2871795 (1106303)
An issue when using MFFTP to transfer a file that has consecutive CRLFs has been corrected.

•

2870653 (1106015)
You no longer receive a U4038 abend when calling MFJZLPSA with a JCL that uses DFSRRC00 and
BMP.

•

2869477 (1105804)
An RTS114 error in IDAMJRM, when renaming a dynamically allocated GDG bias using MFJCTLBP,
has been corrected.

•

2868312 (1105647)
An issue with tracing messages from MVSSPLHK could result in receiving an RTS 114 error message.

•

2867854 (1106300)
A problem that sometimes caused IEBCOMPR\MFJMATCH results to be truncated has been fixed.

•

2867057 (1105644)
The catalog xml utility, mfcatxml, now supports the export and import of VSAM-SHARE-OPTS using the
GDG-EMPTY-COUNT field.

•

2866823 (1105394)
Under VSE, when the environment variable ES_SAM_ESDS is set to Y, an open OUTPUT of a reusable
ESDS file resets the file in situations when the DISP is not specified in the DLBL statement.

•

2865599 (1105186)
The catalog list function now returns correct results when user catalogs exist.

•

2865225 (1105120)
When using the JOB KEEP option of MVSSPLHK without a duration parameter, the job was removed.
2864643 (1105034)
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•

The JES000915E error message now shows the correct userid.

•

2856571 (1103927)
Some issues with the performance of MFJAMS LISTCAT processing have been fixed.

•

•

•

•
•

2809335 (1105962)
The number of supported user catalog nodes, MFUSERCAT_NODE and MFUSERCAT_LOC, has been
increased to 64.
2805554 (1106346)
If you have enabled 7-digit job number support via MF_MVSJOB, to revert to 5-digit support, set
MF_MVSJOB=<low number>+<high number> where high number is less than 0099999, and ensure
that the '+' sign is used to separate the low and high values.
You can now make catalog searching and filtering more consistent with the results produced on the
mainframe by setting ES_CATLG_DISABLE_ADDITIONAL_QUAL=Y. Setting this variable to Y emulates
the effect of disabling the ‘Include Additional Qualifiers' option on the mainframe. The default setting for
ES_CATLG_DISABLE_ADDITIONAL_QUAL is N.
2883777 (1107870)
Trying to delete a job record no longer fails with a Run-Time System error 173.
2876102 (1106778)
ES_ESM_IGNORE_PDSM_RULE must be set to 'Y' to ensure that the access to PDS members in
ESMAC is controlled by the access privileges to the PDS itself.

•

2869207 (1105872)
The support for catalog listings using wildcards has been improved.

•

2860297 (1104531)
Using the JOB field (and then Delete) to delete all SYSOUTs of a job now works as expected.
2857238 (1104017)

•

•

•
•

•

Conditional execution of the MFPAUSE user exit is enabled if the PAUSE statement follows an IF
statement.
2869354 (1105809)
DLBLs in the VSE configuration file are now allocated correctly when the JCL contains a PAUSE
statement.
2867871 (1105749)
A problem with MFFTP that prevented the FTP of an empty ESDS file has been fixed.
2867363 (1106130)
To prevent interference with MFFTP execution when running under VSE, edit the VSE configuration file
USE-SYSIN section for MFFTP and assign the permenant instream DD name to SYSIPT (IPTSYS).
2864865 (1105434)
Jobname information is no longer carried forward from one VSE job to the successive jobs.
2864594 (1105072)

Mainframe Access
Back to the list
•

The "$" and other national characters are now included in Endevor member filters.

•

3103132 (1109163)
A z9 compatible version of MFA is available on request from your Support Engineer or Account
Manager.
2885220 (1108073)
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•

•

•
•

You no longer need to use the MFA4ENDV LRECL override table when using Endevor types with a
source length greater than 80.
2878450 (1107406)
After an MFDAS IMPORT failed with an open error on a data set the associated file handle was not
freed. This could potentially lead to the depletion of all MFA file handles.
2878272 (1107023)
Line sequential output is now correctly handled by the MFA file handler (Data Connect).
2878168 (1107430)
Mainframe Access server provides a new command, UNLOCK, with the following syntax: F
MFA,UNLOCK,DSN=aaa.bbb[,MEM=mmmmmmmm] You can use this command in situations where a
user has terminated an AWM edit session which left the member lock active. To display MFA ENQs, use
IBM's TASID (option 3) application from ISPF. This application provides a much better display than the
console display.
2860316 (1104416)

•

•

Customers using non-US code pages no longer receive errors when doing bulk member import with
mfmonmx2.
2881013 (1107577)
The mfmon2 utility now only performs an initial download if the Micro Focus PDS does not have any
ISPF statistics.
2872024 (1106302)

•

Previously, for catalog filters specified in "mfdas cat ..." commands, the character '#' was translated to
'%', which is interpreted as match any character. Since '#' is actually a valid alphabetic character in US
EBCDIC and can be used in data set names, this behavior caused unexpected problems with catalog
services. This feature has now been deprecated.
2877352 (1107173)

Micro Focus Batch Scheduler Integration
Back to the list
•

MFBSIJCL now returns the return-code 219 when the batch SEP is killed.

•

2881528 (1107507)
MFBSI now writes back the Control-M %%INCLIB statement in the submitted JCL. This is to help
identify the origin of JCL statements.

•

2868077 (1105595)
The MFBSI Control-M AutoEdit emulation is now ignoring the IF/ELSE statements block when the
condition is false.

•

•

2863481 (1104860)
The default delays used by MFBSIJCL to check for a job state in Enterprise Server are as follows - two
seconds before each check for "Job Started" and ten seconds before each check for "Job Concluded". It
is now possible to configure these delays in the MFBSI configuration file, mfbsi.cfg, with the following
two new parameters - JOBSTART-LOOKUP-FREQ and JOBEND-LOOKUP-FREQ. Both parameters
accept values between 1 and 60 (in seconds), and AUTO. When AUTO is used, MFBSIJCL uses an
initial frequency of one second for three minutes after which the default values are restored. Using these
parameters will significantly reduce the overhead elapsed time in MFBSIJCL when compared to the
Enterprise Server JCL reported execution time of a job. This has an effect mainly in scenarios when you
have short-running jobs that are frequently executed.
2857416 (1105116)
MFBSI now resolves the Control-M statements %%INCLIB and %%LIBSYM using the DSN located in a
user-defined Catalog.
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Micro Focus Directory Server
Back to the list
•

Fixed a memory leak in the MFDS process.

•

2876419 (1106799)
A memory leak in the MFDS process occurred if non-SSL-enabled connection attempts were made
against an SSL-enabled MFDS. This has now been fixed.

•

2869493 (1106567)
The MFDS -g command-line option now correctly handles the import of multiple region definitions from
a single XML file.

•
•

2840162 (1101798)
An issue that could potentially cause heap corruption in MFDS if the configuration data for an individual
object was greater than 1K has been fixed.
The "Renew" option available in the Enterprise Server Administration Web interface now works if SSL is
enabled.

Monitoring and Management
Back to the list
•

JCL jobs that generate STEPBYPASSED events no longer cause incorrect values in JCL HSF records.

•

2886646 (1108200)
Spurious STEP BYPASSED events for dummy steps were being passed to the user exit and the HSF
exit.

•

2873504 (1106446)
An issue where duplicate HSF records could be created has been fixed.
2856941 (1103977)

OLE Class Library
Back to the list
•

A problem with accelerator keys being handled by an ActiveX control has been fixed.
2990224 (1108719)

OpenSSL
Back to the list
•

The version of OpenSSL included in this product has been updated to version 1.0.2j.

PL/I Support
Back to the list
•

MOD function now works correctly with char string arguments.

•

2880086 (1107327)
Using RETURN inside a SELECT now works correctly.

•

2877979 (1107006)
A problem when using SUBSTR as an argument to UPPERCASE has been fixed.
2863064 (1104802)

•

48

| Resolved Issues

A problem invoking a function call using an entry variable with the unaligned attribute (or compiled -zp1)
has been fixed.

•

•

3107510 (1109544)
Diagnostic message 2012 has been changed as follows: Internal IL overflow. Unable to continue
processing. Try breaking the compilation unit apart into smaller modules if possible, or reducing the
number of executable statements. If this message persists, contact Micro Focus SupportLine.
3106231 (1109494)
mfplx32 and mfplx64 will now always compile in correct mode.

•

3105182 (1109296)
A problem calling a function with no arguments and a fixed decimal return type with non-zero scale has
been fixed. This problem was limited to calling the function without (), e.g., call func;

•

3104790 (1109255)
A problem with restricted expression evaluation of initializers when the GLOBALDEF attribute is
specified has been fixed.

•

3104276 (1109288)
A problem when passing structure arguments to structure parameter descriptors that was not of the
same shape is now properly diagnosed.

•

2991300 (1108810)
Passing duplicate string literals as function parameters now works correctly when compiled using -opt.

•

2991006 (1108785)
A problem when using both the compiler options -graphic and -fdmaxp has been fixed.

•

2990363 (1108706)
A problem with an assignment of a non-array structure to array of structure has been fixed.

•

2912429 (1108422)
A problem diagnosing an expression used as data-list item has been corrected.

•

2883992 (1107886)
Using TRIM as a parameter to another built-in function now works correctly.

•

2882983 (1107722)
A problem with array structure assignment requiring conversion has been fixed.

•

2882731 (1107654)
Assigning ''G to a graphic variable now works correctly.

•

2881762 (1107513)
The compiler now diagnoses possibly uninitialized automatic variables at the point of first use as seen in
the source program, if not previously set by an assignment statement, or passed-by-reference as an
argument in a procedure call.

•

2881037 (1107420)
ENTRY with the LIMITED attribute is now supported. Restriction: ENTRY LIMITED with STATIC INITIAL
is not currently supported (AIX only).

•

2881035 (1107482)
The STRING built-in function has an implementation limitation of its result length of up to 32767 bytes.
The compiler now diagnoses this limitation for a non-variable length result with an S-level diagnostic.

•

2880813 (1107384)
mfpli no longer loops endlessly when compiling some programs with the -pic option.

•

2878919 (1107206)
An erroneous diagnostic citing an invalid DEFINED overlay has been corrected.

•

2871953 (1106212)
An issue with GRAPHIC string comparisons has been fixed.
2869451 (1105800)
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•

A problem with initialization of structures containing a CHAR(0) member has been fixed.

•

2868923 (1105719)
A problem with passing an unconnected array reference to an argument with CONNECTED in its
descriptor has been fixed.

•

•

•
•

2868606 (1105886)
A new compiler option "-default connected" (or "-dft conn") applies the CONNECTED attribute to array
parameter descriptors by default. When passing arguments to parameters without an explicit
CONNECTED attribute, the compiler assumes the callee parameter to be connected. If the caller
argument is unconnected (discontinuous in memory), a dummy connected argument is created at the
call-point. The NONCONNECTED attribute when explicitly applied to parameter descriptors overrides "default connected".
2868606 (1106271)
The compiler now diagnoses PICTURE specifications which cause internal compiler implementation
limits to be exceeded.
2868176 (1105602)
A problem with GRAPHIC concatenation causing a SIGSEGV has been fixed.
2867892 (1105565)
Repeat factors for PIC X and PIC A specifications are now allowed up to 255. The maximum total field
width of a picture specification remains at 255 bytes, now documented under Implementation Limits in
the Open PL/I User's Guide.

•

2867770 (1105548)
A problem with an ENTRY invocation without () has been fixed.

•

2867705 (1105540)
A problem with a comparison of a BIT(1) to a numeric literal or FIXED BINARY variable has been fixed.

•

2866657 (1105363)
A possible problem with the scoping of implicit and contextual declarations has been corrected.

•

2865207 (1105109)
The diagnostic message MFPLI00176S when issued erroneously has been fixed. The text of the
diagnostic has also been corrected and changed to W-level.

•

2864859 (1105066)
A problem with EBCDIC conversion of string literals under the Japanese locale has been corrected.

•

2859505 (1104311)
A problem calling entry variables based on pointers has been fixed.

•

2840869 (1101873)
The CHARVAL built-in is now supported.

•

(627778)
The relational operator <> is now supported. It is equivalent to "Not Equals".
(625262)

•

Previously, if the user had set TMP, TEMP, or MFPLI_CONFIG_DIR to a non-existent directory and
attempted to debug a JCL Jobstream using CodeWatch, the job was wrongly terminated. A new CTF
diagnostic is now generated which will allow the user to determine that they've incorrectly set the
directory to be used for temporary files.
2882313 (1108052)

•

Previously, a diagnostic was issued if a macro variable was declared twice. It is now only issued if the
second or subsequent declaration has different attributes from the initial declaration.
3108673 (1109680)
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•

Previously, if a nested macro was invoked using a parameter that had been omitted, but which had a
value assigned in the enclosing macro, the nested macro did not receive the parameter value.

•

3105212 (1109323)
Previously, the macro preprocessor issued a syntax error when a macro preprocessor variable was
declared using the SCAN or NOSCAN attributes.

•

3104598 (1109315)
Previously, if the ANSWER statement was used in a PL/I Macro, the resulting output was not rescanned
for replacement prior to being driven to disk.

•

•

•

2887974 (1108455)
Previously, if using the PL/I Macro Preprocessor to handle code which contained IBM's newest operator
"<>" for "Not Equal", an error message was generated. The Macro Preprocessor has been enhanced to
accept <> as not equal.
2885570 (1108085)
A previous fix related to the use of -margins and PL/I exponentiation caused a failure when a macro
expanded and caused a comment to be pushed to straddle the right margin such that the / and * were
split. This no longer occurs.
2884503 (1107984)
Previously, if a % preprocessor statement was on the first valid column of a line which preceded a line
which ended using all available columns and -margins was specified, then the data on the preceding
line could be erroneously omitted. This no longer occurs.

•

2884467 (1107970)
Previously, if declaring macro preprocessor arrays within a factored declaration, they were not correctly
parsed/interpreted. This has now been fixed.

•

2880399 (1107344)
Previously, if using RETURN; within a PL/I Macro, it was flagged as invalid syntax. This no longer
occurs.

•

2880397 (1107334)
The PL/I macro preprocessor now accepts the "_" character in hex literal constants.

•

2880350 (1107312)
The macro preprocessor now supports macro procedures written with a void parameter list.

•

2880349 (1107311)
Previously, the use of open and close parens within the ANSWER expression caused an incorrect result
and/or an error message. This no longer occurs.

•

2880347 (1107314)
An enhancement made to support -incafter in a single macro pass broke the macro preprocessor's
ability to use macro pp built-in functions outside of a macro pp procedure. This has been fixed.

•

2877724 (1106992)
Previously, the macro preprocessor did not support the LEAVE statement for exiting a DO block. It is
now supported.

•

2874544 (1106595)
Previously, the macro preprocessor did not interpret a DO statement with "BY 0" as an infinite loop that
could only be terminated by a LEAVE or GOTO. This has now been fixed.

•

2874169 (1106508)
Previously, the macro preprocessor required the first token in a THEN or ELSE clause of an IF
statement to be a % symbol when parsing outside of a macro procedure. This is no longer required.

•

(627710)
Previously, %PROCESS statements in the code resulted in an error when the code was parsed by the
macro preprocessor. %PROCESS is now parsed/ignored.
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(628209)
•

•

Previously, a CTLASA file that was opened for output but not written to erroneously generated a
CTLASA Page Feed when closed automatically. This has now been fixed.
3105667 (1109464)
Previously, if an AREA variable was part of a structure, and the structure was BASED, AUTOMATIC or
CONTROLLED storage then the AREA was not usable until it was initialized with the EMPTY built-in
function. Enterprise Developer now mimic IBM's behavior and automatically initialize AREA variables to
EMPTY() regardless of whether they are scalar or part of a structure.

•

3104275 (1109498)
Previously, a combination of consecutive PUT SKIP() statements did not generate a series of CTLASA
characters that matched the IBM Mainframe behavior. This has now been fixed.

•

3101399 (1108926)
Previously, if using PUT EDIT LINE() with non-contiguous lines, there was an error in the calculation of
the number of lines that needed to be skipped via CTLASA control characters. This has now been fixed.

•
•

•
•

•

2884058 (1107881)
A problem with PUT SKIP EDIT when driven from an ON ENDPAGE has been corrected.
2882729 (1107653)
A problem with ASA Control characters when utilizing the language feature that skips to a new page
when the specified LINE is <= to the current line has been corrected.
2882011 (1107545)
The MOD built-in fucntion now works correctly with fixed dec or pic variables.
2881986 (1107540)
Previously, an unflushed stream file which contained a buffer that would cause it to match the
PAGESIZE of the file erroneously triggered ENDPAGE upon the close of the file. This no longer
happens.
2879623 (1107246)
Previously, if using PUT PAGE; followed immediately by another PUT statement which included a PAGE
option, there were not two page ejects emitted as CTLASA characters. A secondary problem related to
using the RECSIZE() option of the ENV Attribute to establish a longer than standard LINESIZE for a
stream output file has also been corrected.

•

2875866 (1106719)
An undocumented IBM behavior with regard to the generation of CTLASA control characters for the
second line of the first page of a stream I/O file has been corrected.

•

2873492 (1106402)
A problem with the comparison of two PIC variables which each contained multiple consecutive drift
characters has been corrected.

•

2869873 (1105854)
Previously, if reading SYSIN via a PL/I Program compiled with -ebcdic, from a physical dataset in an
enterprise server region running in EBCDIC mode, the input was garbled. This no longer occurs.

•

•

2865346 (1105128)
Previously, if using PUT SKIP(x) where x is greater than 1, on the first line of the first page of a PRINT
CTLASA file, the use of ASA control characters did not mimic the undocumented behavior present in
IBM's PL/I on z/OS. This has now been fixed.
2864096 (1104958)
Previously, when a CTLASA file was OPEN(ed) and CLOSE(ed) without any data being written, a zero
length file was created. Open PL/I now matches IBM's behavior and emits a single blank page feed line.
2863818 (1104911)
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•

Previously, if using an EXTFH.CFG where the [XFH-DEFAULT] contained INSERTNULL=OFF, the
compiler would trap when compiling larger complex programs while attempting to read back in a
temporary file created during the parsing phase. This no longer occurs.
2863220 (1105599)

•

•

ECM now generates correct code to drive user-specified labels in exec sql whenever goto xxx;
statements.
3105039 (1109297)
The -optsql, -optcics, -optdli, and -optexec compiler options now support strings that can be as large as
2048.
2877088 (1106913)

REX Support
Back to the list
•

•

When running a REXX EXEC under Enterprise Server or Enterprise Server for .NET, an "Invalid
Expression" error occurred for an assignment statement where the expression being assigned to the
variable had been omitted. An empty string is now assigned to the variable if the expression is omitted.
2880655 (1107390)
A REXX exec could fail with a S0C4 abend or an RTS 114 error if it was greater than 4096 bytes in
length and specified either as in-stream data or catalogued as an RECFM=F or RECFM=V dataset.
2878613 (1107100)

RM/COBOL
Back to the list
•

When FILETYPE(21) was specified for a LINE SEQUENTIAL print file, you could receive a Run-Time
System error "13". Writing to a printer from a Visual COBOL program through the RM File Manager
(filetype 21) now works correctly.
2874987 (1106616)

Run-Time System
Back to the list
•

•

Adis SCREEN SECTION ACCEPT statements for PIC N DISPLAY-1 items now correctly accept DBCS
characters with a lead byte of x"87".
3104586 (1109231)
A error when using very long command lines with Profiler (or cobprof on UNIX) has been fixed.

•

2884968 (625185)
You can now double-click (to run) managed executables that use the ACUFH file handler; previously,
they may have failed with a COBRT198 error.

•

2880827 (1107388)
When debugging a native Object COBOL application, the debugger no longer fails with an intermittent
COBRT114 run-time error when getting the type and value of an object's handle.

•

2875531 (1106808)
A multi-threaded application that makes use of the COBOL syntax for handling mutexes, monitors,
events and semaphores, or the corresponding CBL_ APIs, no longer fails intermittently with various runtime errors due to memory corruption.
2860205 (1104446)
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•

•
•

Animating a core file that has been moved to a different directory, for a core file produced by an
application compiled to executable, no longer fails with a "Program is not animatable" error. Previously, it
would on certain platforms.
2856631 (1103933)
Detaching from animation that was started using the debug_on_error tunable could cause animation to
re-start again for the initial error - this has now been resolved.
A 12-byte (32-bit) memory leak has been prevented when calling native COBOL code from JVM
COBOL when using the 'C' call-convention, or the RuntimeSystem.cobcall/cobrcall library APIs, with a
parameter type that is a JVM array.

SQL: COBSQL
Back to the list
•

A problem that caused the COBSQL preprocessor to incorrectly parse comments beyond column 72
has been fixed.

•

3101746 (1108980)
A problem with COBSQL producing a duplicated cursor data item when KEEPCOMP was used has
been fixed.

•

2874051 (1106531)
A problem that caused the COBSQL preprocessor to incorrectly process source lines with characters in
column 73 and beyond has been fixed.
2869958 (1109899)

SQL: OpenESQL
Back to the list
•

•

The OpenESQL preprocessor incorrectly expanded a group host variable used in a CURSOR SELECT
statement, resulting in a run-time error. The preprocessor has been modified to generate a COBES0130
error message in this case.
3104602 (1109289)
A problem the prevented OpenEQL applications calling SQL Server stored procedures with no
parameters when using the legacy 'SQL Server' ODBC driver has been fixed. Important: We strongly
discourage use of the legacy 'SQL Server' ODBC driver. Instead, we recommend that for best
performance and functionality, use the ODBC driver that corresponds to the version of SQL Server used
by the application.

•

3100550 (1109071)
A problem with HCOSS code generation that occurred when duplicating input host variable references
(for example when substr() is used with 2 rather than 3 parameters) has been fixed.

•

3100098 (1108819)
A problem with the OpenESQL native routine that provides DSNTIAR emulation sometimes caused an
RTS114 error. This has been fixed.

•

•

2989595 (1108699)
A new OpenESQL directive, GEN-SQLCA, has been added to generate the SQLCA copybook in a
program when it has not been explicitly included. This directive provides additional support when
migrating applications compiled with STDSQL(YES) on the mainframe.
2887858 (1108368)
A problem with the MSSQL XA switch module sometimes causing a CICS transaction to abort if it
ended without closing all FORWARD and READ ONLY cursors has been fixed.
2887074 (1108340)
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•
•

An inconsistency in reporting data truncation warnings when using PostgreSQL has been fixed.
2886648 (1108201)
OpenESQL and OCI have been updated to to prevent RTS198 errors when using DSNTIAR with
ODBC. To take advantage of this new functionality, specify the cob -d command flag to resolve
DSNTIAR with the correct callable shared object. For example, to compile a COBOL program into an
executable on a 64-bit platform with OESQL DSNTIAR: cob -x program.cbl -d
DSNTIAR@cobmfdsntiar64.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm Or, to compile a PL/I
program into an executable on a 32-bit platform with OESQL DSNTIAR, execute the following two
commands: mfplx -c PROGRAM.pli -sql odbc -optsql "behavior=mainframe nosmftrace" cob -x
PROGRAM.o -d DSNTIAR@cobmfdsntiar.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm

•

2884651 (1107997)
A problem when using OpenESQL for JDBC with the "Use Dynamic Calls" project option has been
fixed.

•

2883500 (1107955)
A problem with SQL(AUTOFETCH) that affected SQL Server FORWARD READ ONLY WITH HOLD
cursors performance has been fixed.

•

2880840 (1107580)
The ADO.NET Run-Time System for OpenESQL now returns the correct value in SQLERRD(3) after a
cursor fetch when other statements are executed between any fetches on the cursor.

•

2880814 (1107386)
OpenESQL now allows FREE to be used as an SQL identifier. It is server dependent if this is supported
at compile time when using SQL(CHECK) and at run time.

•

2880673 (1107368)
A new OpenESQL directive, CLOSE_ON_COMMIT, has been added to provide greater control over
cursor behavior on COMMIT for cursors that are not explicitly declared using WITH HOLD.

•

2879558 (1107305)
A problem with HCOSS handling of nested table references in DB2 statements has been fixed and error
messages when using SQL(STRICTPARSE) have been improved.

•

•
•

2879503 (1107286)
The SQLBGP COBSQL compiler directive option has been added to ensure successful background
parsing of EXEC SQL statements when the Pro*COBOL installation resides on a remote machine and
not on the local machine.
2877618 (1107292)
A problem that prevented SQL(CHECK) from working correctly on some databases has been fixed.
2877284 (1107021)
When used with the SQL(USER-SQLDA=MAINFRAME) directive, the OpenESQL preprocessor could
incorrectly generate ES0100 errors if a group variable was used in an EXEC SQL FETCH statement.
This has been fixed.

•

2876420 (1106803)
The OpenESQL preprocessor sometimes failed to return comp data items correctly if compiled with
SQL(DIALECT=MAINFRAME). This has been fixed.

•

2874931 (1106606)
The OpenESQL preprocessor has been updated to generate a more meaningful message,
COBES0129, when it encounters an undefined host variable.

•

2874408 (1106624)
A problem with SQL(NORSLOCATORS) leaking SQL Server server cursors has been fixed.
2872613 (1106294)
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•

•

•

•

•
•

•
•

•

HCOSS handling of the DB2 CHAR() function did not always properly apply the compile-time settings of
DATE and TIME as the default formats when CHAR was called with a date or time value but no date or
time format parameter was supplied. This has been fixed.
2872518 (1106404)
A new SQL compiler directive option, OPTIMIZECURSORS, has been added to optimize memory
consumption when using OpenESQL for ADO.NET with Oracle, DB2, or PostgreSQL. The default
setting is SQL(OPTIMIZECURSORS=YES). See the OPTIMIZECURSORS reference topic in the
documentation for complete information.
2871132 (1106056)
Decimal and host variables with the same length are now converted to EBCDIC correctly when
CHARSET(EBCDIC) is enabled; however, if you link native COBOL applications that use display
numeric variables in SQL statements using CHARSET(EBCDIC), you might get a link error. To resolve
this issue, see the OpenESQL topic under Known Issues and Restrictions.
2857755 (1104091)
A problem with the ODBC switch module not reporting broken connections to Enterprise Server when
xa_start() is called has been fixed.
2843672 (1108847)
A problem that caused the OpenESQL preprocessor to incorrectly interpret UNICODE(PORTABLE) has
been fixed.
The SQL xa_open string has been updated to include the PACKAGEPATH option, which enables the
use of substitution markers to customize the package path based on the current JCL or CICS user
name, XA resource name, enterprise server region name, or a combination. In addition, when used with
the UserP option, the PACKAGEPATH option value changes when the user for the connection changes.
A problem using SQL(DATEDELIM) with SQL(DATE=JIS) has been fixed.
OpenESQL has been updated to enable execution of selected SQL statements at compile time. You can
use this functionality to create temporary tables during compilation and to enable the use of
SQL(CHECK) with temporary as well as permanent tables.
The encoding of the sqltype fields in SQLDA has changed and any applications that use dynamic SQL
with SQLDAs might require application code change. The new sqltype encoding scheme adds 0x2000
to sqltype when an integer, a small integer or a big integer host variable is COMP and 0x1000 and when
any indicator host variable is COMP. Otherwise, COMP-5 is assumed for indicators and for integer,
small integer and big integer host variables.

SQL Option for DB2
Back to the list
•

A problem with the Declaration Generator that prevented COBOL copybooks from being generated
correctly for tables with timestamps and XML columns has been fixed.
2875742 (1106868)

•

•

The XDB preprocessor has been updated to support source connect files that previously generated a
"File not found" error for EXEC SQL INCLUDE statements located on the source connect drive.
2912819 (1108471)
The XDB ECM has been enhanced to handle temporal table query syntax.
2876438 (1106807)

•

Implemented the JDBC ResultSet Interface getBigDecimal methods that do not require a scale
argument: getBigDecimal(int columnIndex) and getBigDecimal(String columnLabel).
2877817 (1106963)

•

A problem that caused an X020 syntax error on SELECT DISTINCT (TRIM)has been fixed.
3105393 (1109324)
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•

A problem that prevented the XDB engines to successfully process a COUNT(DISTINCT expression)
scalar function when the expression was a concatenated expression enclosed in parentheses has been
fixed.

•

2884227 (1107903)
A problem that caused a thread stack overflow on scalar function recursions that use CONCAT has
been fixed.

•

2884046 (1107882)
A problem with the XUTLB LOAD grammar prevented the reserved word DATE from being used as a
table name. This has been fixed.

•

2882727 (1107652)
An problem when correlating a subquery produced a PDMP242 error. This has been resolved.

•

2880672 (1107367)
A problem that caused a FETCH FIRST clause in a scalar subquery to be ignored has been fixed.

•

2880671 (1107366)
A problem using the reserved word DOCUMENT as an identifier in the first argument of a scalar
function has been fixed.

•

2874154 (1106483)
CAST AS TIMESTAMP using the special character 'T' as the date/time delimiter was not allowed. This
is now allowed.

•

2874153 (1106484)
An issue with the ordering of a result set caused the incorrect row to be returned on a FETCH FIRST
ONLY clause. This has been fixed.

•

2873390 (1106435)
An issue with index optimization of LIKE predicate processing has been resolved.

•

2873389 (1106391)
A problem that sometimes caused the XDB Server to shut down before completing location checkpoint
operations by maintenance threads has been resolved.

•

2847090 (1102750)
An problem with LIKE predicate index query optimization that caused missing result set rows has been
fixed.

•
•

2841168 (1101910)
A problem that prevented the restoration of LOB data from a record with an LOB column after deleting
the record and then rolling back from a Save Point has been fixed.
XDBMONN has been updated to issue the correct error message when it is started, but the server is
not running.

•

The server Name be displayed in the status bar of the XDB SQL Wizard.

•

2865763 (1105197)
Using ALLOW EDITING on an SQLWizard result set could result in the query being corrupted. This has
now been fixed.

•
•

2865336 (1105171)
The restriction that prevented the editing of result sets generated from alias tables has been removed.
2857585 (1104067)
When the SQLWizard is invoked by MFA Drag & Drop to import unload data to a table it no longer
returns an X352/X95 error.

XML Support
Back to the list
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•

XMLPARSE no longer returns -19 in XMLSS mode.

•

2913116 (1108661)
Opened XML files are now closed when the COBOL program called by JCL is terminated.

•

•

2885450 (1108132)
A new directive "OUTENC(INPUT)" is created to ensure encoding of the output text will be the same as
the input encoding specified in the XML declaration.
2870879 (1106332)
XMLIO now handles REDEFINE data items correctly.
2795744 (1096302)

z/Server
Back to the list
•

z/Server failed to initialize when user servers where configured to run as jobs. This has now been fixed.

•

2913201 (1109196)
Message STA0009I was enhanced to specify the owner of a port if it is unavailable.

•

•

2844223 (1102640)
An attempt to read a spanned format data set (RECFM=VS) from the JES spool will now result in an
error message being sent.
2832616 (1100902)
The MULTI_REXX_S and MULTI_REXX_U options are now correctly processed.
2798844 (1096758)

•

The z/Server listener looped if a temporary shortage of worker tasks occurred. This has now been fixed.
2877286 (1106920)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2884374 (1107928)
2875256 (1106645)
2871954 (1106649)
3103304 (1109198)
2857117 (1106716)
3106240 (1109462)
2989573 (1108689)
2874306 (1106666)
2848671 (1102872)
2878662 (1107084)
2864100 (1104959)
3101450 (1108990)
2884755 (1107973)
2884754 (1108098)
2883962 (1108118)
2883962 (1108119)
2878826 (1107101)
2878227 (1107012)
2877589 (1106938)
2875248 (1106679)
2874812 (1106627)
2874077 (1106516)
2872027 (1106210)
2869739 (1105894)
2868086 (1105954)
2864170 (1105040)
2864164 (1105035)
2990780 (1108760)
2884757 (1108096)
2883769 (1107830)
2851153 (1103313)
3101883 (1108971)
3101148 (1108902)
2885725 (1108103)
2884537 (1107964)
2878485 (1107076)
2876638 (1107036)
2872931 (1106328)
2872035 (1106199)
2867270 (1106437)
2837526 (1104757)
3101467 (1109005)
2879947 (1107389)
2879908 (1107247)
2878412 (1107371)
2852872 (1107046)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2989831 (1108862)
2875722 (1106767)
2875245 (1106642)
2858289 (1104218)
2839585 (1102006)
2869862 (1105851)
2857086 (1104025)
2831639 (1100766)
3102063 (1108996)
3101684 (1108956)
2884727 (1108008)
2881493 (1107488)
2860914 (1104582)
3105709 (1109380)
3105708 (1109382)
3105707 (1109383)
3105704 (1109377)
3105703 (1109374)
3105221 (1109372)
3105219 (1109379)
3105218 (1109371)
3105217 (1109375)
3105217 (1109376)
3105216 (1109370)
3105215 (1109368)
3105214 (1109369)
3104634 (1109245)
3103928 (1109267)
3103824 (1109284)
3102104 (1109041)
3101976 (1109010)
3101690 (1109039)
3101030 (1108911)
3101028 (1108930)
3101027 (1108932)
3100325 (1108856)
2988233 (1108531)
2912393 (1108452)
2912391 (1108451)
2912389 (1108442)
2912387 (1108439)
2912355 (1108501)
2912354 (1108450)
2887976 (1108736)
2887970 (1108418)
2887419 (1108331)
2886979 (1108286)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2879488 (1107196)
2877587 (1106984)
2877474 (1106937)
2877189 (1106921)
2874594 (1106590)
2874591 (1106575)
2874313 (1106592)
2873877 (1106610)
2872737 (1106316)
2872474 (1106964)
2871631 (1106297)
2869907 (1106670)
2869898 (1106147)
2869892 (1105900)
2869763 (1105896)
2864092 (1106070)
2852872 (1103790)
2852872 (1106311)
2852872 (1107278)
2799183 (1096680)
2991138 (1109121)
2875556 (1106727)
2873522 (1106485)
3101858 (1109029)
2883840 (1107954)
2882062 (1107704)
2871525 (1106466)
3106697 (1109529)
3109683 (1109781)
2871797 (1106201)
2816310 (1104173)
3100167 (1108936)
2989831 (1108879)
2796532 (1096369)
3105586 (1109338)
3105375 (1109313)
3102818 (1109347)
2875983 (1106861)
2875103 (1106822)
2988894 (1108994)
2870824 (1106018)
2875885 (1106721)
2886300 (1108160)
2883994 (1108116)
2876768 (1106926)
2875396 (1106686)
2887853 (1108380)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2881573 (1107673)
2878429 (1107279)
2876370 (1107219)
2871569 (1106143)
2867842 (1105600)
2867117 (1105493)
2853200 (1103409)
2885043 (1108044)
2876773 (1106847)
2869095 (1105803)
2865595 (1105786)
2860304 (1104472)
2883686 (1107844)
2865350 (1105129)
2864599 (1105025)
2873863 (1106487)
2870740 (1106000)
2866084 (1105259)
2864758 (1105772)
2989939 (1108666)
2878067 (1106990)
2877643 (1107028)
2873883 (1106635)
2819070 (1099603)
2657473 (1090356)
2869213 (1105788)
3103252 (1109178)
3103241 (1109176)
2991312 (1108795)
2887454 (1108358)
2882453 (1107614)
3100079 (1108823)
2887733 (1108399)
2880976 (1107464)
2877232 (1106950)
3102272 (1109059)
3101639 (1109086)
2886684 (1108370)
2884612 (1108024)
2879358 (1107190)
2878631 (1107110)
2877721 (1106966)
2876808 (1106856)
2876719 (1106845)
2875613 (1106730)
2873607 (1106420)
2873447 (1106429)
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•
•
•
•
•
•
•
•
•
•
•
•
•
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2851640 (1103228)
2603382 (1087028)
2871769 (1106474)
2876285 (1106842)
3107224 (1109628)
2880556 (1107803)
2879876 (1107263)
2880593 (1107378)
3105620 (1109342)
2991280 (1108799)
2882386 (1107606)
2881902 (1107890)
2879176 (1107150)
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•
•
•
•
•
•
•
•
•
•
•
•

2885859 (1108130)
2885529 (1108083)
2884236 (1108000)
2883551 (1107800)
2881659 (1107500)
2881243 (1107455)
2881040 (1107414)
2881038 (1107416)
2881037 (1107419)
2881036 (1107423)
2880647 (1107399)
2879819 (1107333)

•
•
•
•
•
•
•
•
•
•
•
•

2883907 (1107872)
2874406 (1106565)
2873249 (1106552)
2871661 (1106145)
2863482 (1104862)
2848848 (1102895)
2866216 (1105926)
2883667 (1107815)
2880475 (1107343)
2871842 (1106178)
3102432 (1109463)
2887808 (1108624)

•
•
•
•
•
•
•
•
•

2873158 (1106378)
2873035 (1106735)
2871178 (1106125)
2870557 (1106194)
2865051 (1105317)
2859144 (1104286)
2146936 (1059549)
2876653 (1106832)
2865001 (1105155)

Unsupported Functionality
The following features or functionality are no longer supported:
•

The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.

Unsupported Functionality
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Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows
System Requirements
Hardware Requirements
Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
The disk space requirements for Windows are, approximately:
Enterprise Developer
3.5GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.
z/Server requirements
z/Server has the following hardware requirements:
•

IBM mainframe model z9 or later is required for installing and using z/Server. z/Server will not install on
earlier hardware models.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note:
•
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Enterprise Developer installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup
file does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.

•
•

Enterprise Developer enables you to produce both 64-bit and 32-bit applications on 64-bit
operating systems.
This product can be installed on earlier versions of Windows but it has not been tested on them.

Software requirements
Note: This product includes OpenSSL version 1.0.2j.
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
Eclipse requirements
•

The setup file installs Enterprise Developer and the 64-bit Eclipse 4.6.0.
Some earlier versions of Eclipse are also supported. See Installing Enterprise Developer into other
instances of Eclipse in the Advanced Installation Tasks.
Note: If you are installing Enterprise Developer into Eclipse 4.5, or 4.6, you must install the Eclipse
Target Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):

•

•

1. Click Help > Install New Software in Eclipse and add a new repository for the location
http://download.eclipse.org/tm/updates/4.0.
2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.
Enterprise Developer installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file
does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.
Enterprise Developer supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to
create both 32-bit and 64-bit applications.

Software requirements on Windows
•

•

•

Oracle's Java Platform (64-bit) version 1.8.92 or above is required to run the Eclipse IDE. Java 7 and 8
(32 or 64-bit versions) are supported for executing JVM COBOL code and for native COBOL and Java
interoperability. You can download Oracle's Java EE from Oracle's web site and install it anywhere on
your machine.
Note: If Java 7 is installed on your machine, you can skip installing Java 8. Run the setup file with
the skipjre=1 command line option to do this.
Enterprise Developer requires:
• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.
The setup file also installs .NET Framework v4.6.2 and the Microsoft's Visual C++ 2010 and 2012
Redistributables.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.
Other Requirements
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
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microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.
Additional Software Requirements on Windows
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.
Click here to see this information in the Micro Focus Infocenter.

Product Co-Existence
Note: The following applies to Windows only.
•
•

Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:
•

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

On UNIX
System Requirements for Micro Focus Enterprise Developer UNIX
Components
Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

the installation

running

license
server

the product
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POWER
running AIX

Micro Focus

513 MB

2.05 GB

1.03 GB

35 MB

HP IA

Micro Focus

909 MB

3.64 GB

1.82 GB

66 MB

System Z
running Red
Hat Linux

Micro Focus

409 MB

1.64 GB

818 MB

34 MB

x86-64
running Red
Hat Linux

Micro Focus

512 MB

2.05 GB

1.02 GB

44 MB

Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

the installation

running

license
server

the product
ppc64le
running Red
Hat Linux

Micro Focus

301 MB

1.20 GB

602 MB

1 MB

SPARC
running
Solaris

Micro Focus

519 MB

2.08 GB

1.04 GB

38 MB

System Z
Micro Focus
running SUSE
SLES

271 MB

1.08 GB

542 MB

1 MB

x86-64
Micro Focus
running SUSE
SLES

519 MB

2.08 GB

1.04 GB

44

ppc64le
Micro Focus
running SUSE
SLES

271 MB

1.08 GB

542 MB

1 MB

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements for Micro Focus Enterprise Developer UNIX Components
These are the software requirements for Micro Focus Enterprise Developer UNIX Components:
•

•

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.
If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 11

SUSE 12

Red Hat 6.x

Red Hat 7

glibc

glibc-*.i686 glibc*.x86_64

glibc*.s390

X

X

libgcc

libgcc*.i686

libgcc*.x86_64

libgcc*.s390

X

X

libstdc++

libstdc++*.i686

libstdc++*.x86_64

libstdc++*.s390

X

X

X

X

glibc-locale glibcglibclocale-32bit locale-2
glibc-devel

glibc-devel- glibc-devel- glibc-devel*.i686
*.x86_64
*.s390

X

X
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Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 11

SUSE 12

Red Hat 6.x

Red Hat 7

elfutilslibelf

elfutilslibelf.i386
or elfutilslibelf.i686

elfutilslibelf.x86-6
4

N/A

X

X

libelf-devel

elfutilsdevel.i386
or elfutilsdevel.i686

elfutilsN/A
devel.x86-6
4

X

X

libelf-devel

libelflibelfN/A
devel-32bit- devel-0.137
0.137-8.19 -8.19

X

X

libelf1

libelf1-32bit libelf1-0.13 N/A
-0.137-8.19 7-8.19

X

X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.
** Operating system libraries required for PL/I support on both SUSE and Red Hat.
Visit the Red Hat Web site for more information.
•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

Oracle's Java Platform (64-bit) version 1.8.92 or above is required to run the Eclipse IDE. Java 7 and 8
(32 or 64-bit versions) are supported for executing JVM COBOL code and for native COBOL and Java
interoperability. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on
your machine.
Note:
•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute JVM COBOL code, you need to set the environment as follows:
•

•
•
•
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You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 64-bit Java installation or the installation terminates. For example, execute the following:
JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:
gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons
true

Additional Software Requirements for Micro Focus Enterprise Developer UNIX Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.
Click here to see this information on the Micro Focus Infocenter.
UNIX and Linux Installer Issues
Installing on Linux
On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:
•
•
•

Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 32-bit Java version. For example,
untar in /usr/local/java64 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and
run Enterprise Developer.

Installing while using AFS/Kerberos authentication
If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify EDadminID=[User ID] on the command line so it is used by the installer.
License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.
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Installing on Windows
Note:
•
•

This version of the product is a full install.
If you have an earlier version of Enterprise Developer installed on your machine, check Installing
as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:
1. Run the ede_30.exe file and follow the wizard instructions to complete the installation.
By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.6 64-bit, with the Micro Focus
plugins already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse
directory.
The setup file installs any missing prerequisite software as listed in the topic Software Requirements.
Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have a more recent Java 8 update version installed on your machine and you want to
skip installing Java 8 update 102, run the setup file from the command line with the skipjre=1
command line option.

Installing Micro Focus Enterprise Developer UNIX
Components
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_entdev_3.0_platform
2. Run the installer from the Process User ID login:
./setup_entdev_3.0_platform
When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.
The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).
SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_entdev_3.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.
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Note:
During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.
All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.
By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.
The advanced installation tasks include:
•
•
•
•
•
•
•

Installing as an Upgrade - included in these Release Notes
Command line installation options - included in these Release Notes
Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter
Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus
Infocenter
Installing into other instances of Eclipse - available in the product Help and in the Micro Focus
Infocenter
Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into
IDz, z/Server - available in the product Help and in the Micro Focus Infocenter
Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus
Infocenter

Click here to see this information on the Micro Focus Infocenter.

On Windows
Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.
•

If you have been using the mainframe components of Enterprise Developer for z Systems, see Installing
z/Server as an Upgrade for recommendations about how to upgrade your z/Server installation. Also,
check Backward Compatibility of AWM Models for information about changes that affect your existing
AWM models.

•

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Developer Installation Options
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.
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To see what parameters you can use, execute the following from the command line:
install-file /help
where install-file for the following products is as follows:
Enterprise Developer

ede_30.exe

See the Examples section further in this topic for examples of some of the parameters you can use.
Directory considerations
•
•

You must have read and write access for every directory accessed during the installation.
You can override the default installation folder using the InstallFolder parameter.

•

Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:
/log drive:\path\LogFilename

Installing silently
Use the /q parameter to install silently:
start /wait install-file.exe /q [parameters]

Examples
•
•

To silently install Enterprise Developer into a directory other than the default:
start /wait ede_30.exe /q InstallFolder=c:\DirectoryName
If you want to silently install the Eclipse IDE in a location other than the default, execute:
start /wait ede_30.exe /q InstallFolder2=c:\EclipseInstallDirectory

•

To skip installing JRE when installing Enterprise Developer:
start /wait ede_30.exe /q skipjre=1

•

To silently install Rumba during the silent install of Enterprise Developer:
start /wait ede_30.exe /q RumbaCheckbox=1

On UNIX
Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it.
Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer UNIX Components installer with the –installlocation option:
1. Execute the following command:
./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:
. /opt/microfocus/EnterpriseDeveloper/cobsetenv
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Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer UNIX Components Installation
Options
Installing into a different location
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_entdev_3.0_platform -installlocation="full path of new location"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter the help option.
Configuring the Enterprise Server installation
You can use the following options to configure the Enterprise Server installation: [ ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
-ESsysLog

Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
-CASrtDir

Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
You can use the following command line arguments to install silently on UNIX/Linux:
–silent -IacceptEULA
For example, execute:
[as root] setup_filename –silent -IacceptEULA

Installing on Microsoft Terminal Server and Citrix
Note: This document is a work-in-progress. Check the documentation for Enterprise Developer in the
Product Documentation section of the Enterprise Developer SupportLine Web site for its most recent
version.
Microsoft Terminal Server and Citrix (TS/Citrix) are environments for running multiple instances of a single
user product. They are not platforms where a single-user product can be made to perform as a multi-user
product.
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When running Enterprise Developer on TS/Citrix machine, there might be some implications to
components of Enterprise Developer which could cause potential conflicts between a ‘per-user session’
compared to the standard ‘per machine’ setup. The following components of Enterprise Developer require
special configuration:
•
•
•

Eclipse workspaces and projects
The Enterprise Server component - the Run-Time System product for JCL, CICS and IMS operations
The database management service

You can use Enterprise Developer with TS or with any Citrix version certified for use with Eclipse; however,
a separate end-user license is required for each user who accesses Enterprise Developer, even if it is
running on a single machine. See your End User License Agreement for clarification.
Note: Micro Focus Enterprise Developer does not officially support TS/Citrix. However, it will run on
any prerequisite Operating System that is supported under TS/Citrix.
Capacity planning
Multi-user capacity planning for TS/Citrix does not scale linearly, and the calculations required for this
planning are not directly related or specific to any Micro Focus technology. Micro Focus recommends that
you consult with Microsoft or Citrix Systems, respectively, about the server sizing and capacity planning,
based on hosting the required number of “rich” Windows 7 or Windows 8 desktops (e.g. using a singleton
desktop build as a baseline).
Installing Enterprise Developer
To install Enterprise Developer for use with TS/Citrix:
1. Log on to the physical terminal or Citrix server with a user ID that has administrator privileges.
2. Use the download links in your Electronic Product Delivery email.
3. Follow the links for the installation instructions and the End User License Agreement.
Configuring Enterprise Developer
Follow the links below for details on how to configure the individual Enterprise Developer components.

Customizing the Installation, the Workspace and the Projects
Using Enterprise Developer for Eclipse under TS/Citrix
For considerations about how to use Eclipse under TS/Citrix refer to the Eclipse product help.
Micro Focus recommends you set up Enterprise Developer for Eclipse so that each user has their own
configuration area and you make the configuration folder within the Eclipse installation read-only.
(Enterprise Developer for Eclipse is installed on the TS/Citrix machine into %ProgramFiles(x86)%
\Micro Focus\Enterprise Developer with the Eclipse installation stored in C:\Users\Public
\Micro Focus\Enterprise Developer\eclipse.)
To ensure that each user will have their own configuration area, you need to set up Eclipse as follows:
1. On the TS/Citrix machine, start Enterprise Developer once, make any required customizations to the
IDE and then close it.
2. Using Windows Explorer, navigate to C:\Users\Public\Micro Focus\Enterprise Developer
\eclipse and open the eclipse.ini file with an editor.
3. Add the following code before the -vmargs entry:
-configuration
@user.home\EclipseConfig
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4. Using Windows Explorer, navigate to the Eclipse installation folder and from the folder properties make
the configuration folder Read Only for the group that will work with Enterprise Developer for
Eclipse.
This ensures that each user that starts Enterprise Developer for Eclipse under TS/Citrix can only see their
own workspaces and that they have their own EclipseConfig folder specified by the eclipse.ini file.
Eclipse workspaces
An Eclipse workspace is a folder on the disk where the project and application files are stored. The default
location for an Eclipse workspace is in the user's area (for example, c:\users\username\). It is not
possible to share workspaces so each user must have their own.
We suggest that you create Eclipse workspaces in an area on a shared network drive, naming each
workspace folder with an individual user ID.
Also provide a startup script that maps the drive dynamically using share names derived from the user ID.
Tip: Use the net use command to connect to, remove and configure the connections to the mapped
drives.
Template projects
Create and configure template projects to distribute among your users. Templates must not include fully
qualified paths. You can store the projects in a source control system and make them available so that
individual users can import them into their own workspace.

Enterprise Server Installation Options
When you install Enterprise Developer, the setup file also installs the Enterprise Server component on the
same machine. There are different ways in which you can configure and use Enterprise Server regions in
TS/Citrix environments. This topic outlines two of the methods and explains what the implications of
choosing them are:
•
•

Use the Enterprise Server component as part of Enterprise Developer installed on the TS/Citrix
machine
Install Enterprise Server or Enterprise Test Server on a separate server

Use the Enterprise Server component as part of Enterprise Developer installed on the TS/Citrix
machine
On the client machines, the developers each use a clone of Enterprise Developer. They also use a clone of
Enterprise Server to create and manage multiple server instances as required.
While this option provides the greatest flexibility, it also consumes the largest footprint per user.
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Install Enterprise Server or Enterprise Test Server on a separate server
You can install Enterprise Server1 or Enterprise Test Server2 on a separate server that does not have TS/
Citrix installed. By default, Enterprise Server installs and runs as a single-instance product and, within an
Enterprise Server, you can operate a number of server instances. Each server provides session and state
management for COBOL applications, as well as optionally interfacing with external resource managers to
coordinate resource updates.
There are two ways to provide server instances to the developers using Enterprise Developer on the TS/
Citrix machine:
•

1

2
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Configure and configure one server instance per developer by specifying different ports. We
recommend defining five-digit port numbers where digits one through three identify the developer and
four through five identify a unique port. For example: port number 10123 defines a TN3270 listener for
developer 1, and port number 10223 defines a TN3270 listener for developer 2.

Micro Focus Enterprise Server provides full application server support for COBOL applications that require
high-performance and mainframe subsystem emulation. Enterprise Server is designed as a multi-user
environment.
Micro Focus Enterprise Test Server is an IBM mainframe application test execution environment on
Windows. Enterprise Test Server enables mainframe IT organizations to perform a variety of pre-production
testing on low cost commodity hardware, avoiding unnecessary cost and delay. Built on proven technology,
Enterprise Test Server exponentially expands the test capacity and enables testing to scale up easily to
meet delivery timelines and quality standards driven by today's business requirements.

This option provides a dedicated enterprise server for testing purposes for each developer, but restricts
each developer to that one enterprise serve instance.
This scenario creates the largest footprint per developer.
•

Or:
Create and configure one server instance per application for use by a single development team. Use a
different port number for each instance as explained above, using the first three digits to differentiate
between applications.

Configuring SQL Option for DB2 (XDB) for Multi-User Environments
SQL Option for DB2 in Enterprise Developer supports scenarios where multiple users use a single XDB
Server installed on a TS/Citrix server. Typically, users in such environments would require their own private
working locations so they can be isolated from each other's activity on the TS/Citrix server and might
require different XDB configuration settings. SQL Option for DB2 provides support for this.
The configuration options for XDB Server are stored in the xdb.ini configuration file installed in the
Windows protected area in C:\ProgramData\Micro Focus\Enterprise Developer\mfsql\cfg.
xdb.ini contains both client-side and server-side settings for the XDB tools.
Changing the server-side settings
In most cases, it is not necessary to change XDB Server's server-side settings. If you need to change
these settings, however, it is important that you use the XDB tools to modify the xdb.ini file as the tools
run with administrator's privileges. This helps avoid some possible issues with Windows virtualizing files in
the protected areas that you try to edit without administrator's privileges.
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See Changing the Main XDB Server Configuration File.
Changing the client-side settings
In multi-user environments such as TS/Citrix, it is important to provide individual users with their own clientside configuration options for XDB. To cater for that, Enterprise Developer provides a utility, XDBSetup,
which creates a private XDB configuration file for each user in their local Windows folder on the TS/Citrix
machine.
Users would run XDBSetup before they start using any of the XDB components on the TS/Citrix server.
They can then use the XDB Client Options utility (XOPT40N) to customize their own version of xdb.ini
and specify any required client-side run-time options and a temporary space for the client-side tools. For
example, they might want to customize various options such as the isolation level, the lock timeout (for
example, if they want a longer record lock timeout for testing), the data formats (if they want a different date
format to test the software for internationalization issues), the SQLWizard configuration, and the private
area for saved files.
XDBSetup also creates some entries in the user's specific area in the registry which point to the location of
the private xdb.ini file. This ensures that XDB Server will use the main xdb.ini file installed under the
c:\ProgramData folder, while any of the XDB tools that individual users start will use the private
xdb.ini files that users might have customized according to their own preferences.
See Creating a Private XDB Configuration File in a Multi-User Environment.
Configuring the private XDB Server options in batch
If all users must have the same environment and use a specific standard set of client-side options in their
private xdb.ini files, a system administrator can set this up for them using a batch file. The batch file
would execute XDBSetup to create the private xdb.ini files and then it would execute BOPT40N, the
batch version of the XDB Client Options utility, to specify the same client-side options in each private
xdb.ini file.
See Changing the Private XDB Server Configuration Files in Batch.
Creating a Private XDB Configuration File in a Multi-User Environment
Before using XDB Server on a TS/Citrix machine, all users must first run the XDBSetup utility to create a
private XDB Server configuration file, xdb.ini, in their local Windows folders.
To run the utility:
1. Log in to the TS/Citrix machine using the Windows Remote Desktop Connection.
2. Execute the following from an Enterprise Developer command prompt:
XDBSetup
See Syntax of the XDBSetup command for more details.
This creates a standard xdb.ini file in the user's Windows home directory, in c:\Users\username
\AppData\Roaming\Micro Focus\Enterprise Developer\mfsql\, for which the user does not
need administrator's credentials to change the file.
This also creates some registry entries in the user's specific area which point to the location of the private
xdb.ini file. When any of the XDB tools are executed, they check the user's registry settings for whether
there is a private configuration file before they check the local machine registry settings which store the
location of the main XDB Server configuration file.
Syntax of the XDBSetup command
The XDBSetup utility can run in either an interactive or unattended mode. Use the following syntax to
execute the utility:
XDBSetup [-u|--unattended]
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Where you can specify the following options:
No options

XDBSetup executes in an interactive mode. You receive some pop-up windows
confirming whether the operation completed successfully, prompting whether to
overwrite a previously installed xdb.ini, and possibly showing any status or error
messages.

-u, --unattended XDBSetup executes in an unattended mode.
Log files:
1. A log of the commands activity is output to the standard error output handle.
2. If you need to receive any standard errors, specify ">" to redirect the standard output. To redirect any
standard errors, use "2>" as a redirection symbol. If this is not specified, any messages are displayed in
the command prompt.
Changing the Main XDB Server Configuration File
The XDB Server configuration file, xdb.ini, is installed in a Windows protected location - in C:
\ProgramData\Micro Focus\Enterprise Developer\mfsql\cfg, by default. You need
administrator's privileges to edit the file to help avoid some problems that Windows file virtualization can
cause.
Micro Focus recommends that you use the XDB tools to edit xdb.ini because the XDB tools include a
Windows manifest that requests administrative credentials for updating files in the Windows protected
areas. You need to run the tools from the command line and specify xdb.ini as an argument. For
example, if you use the XDB Client Options utility, execute:
XOPT40N /i"C:\ProgramData\Micro Focus\Enterprise Developer\mfsql\cfg\xdb.ini"
Avoiding Windows virtualization issues
Files that reside in the Windows protected locations, such as xdb.ini, that reside in the Windows
protected locations require that you edit them with administrative privileges. If you use utilities such as
Notepad that do not request administrator's credentials, Windows file virtualization does not save the
modifications in the actual file you edit but creates a copy of the file in the %userprofile%\AppData
\Local\VirtualStore folder.
From then on, programs that run without administrative credentials use the file in the VirtualStore
folder while those that run with administrative credentials use the actual xdb.ini file which can lead to
some confusing results.
Changing the Private XDB Server Configuration Files in Batch
The XDB Client Batch Options command, BOPT40N, is a batch version of the XDB Client Options utility,
XOPT40N.
You can use BOPT40N to modify the options in the xdb.ini file in batch. The syntax of the command is
as follows:
bopt40n /pSection.Variable=Value
Where:
Section, Variable and Value indicate a section in xdb.ini, a variable in that section and the value you
want to set the variable to.
Note: If any of Section, Variable or Value include any spaces, you must use quotes around the entire
argument. In the following example, the connection name has an embedded space in the section
name so you need to use quotes around the entire argument in the command as follows:
bopt40n "/pConnection MYSERVER.CurrentLocation=MYLOC"
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Configuring Other Components
Micro Focus Rumba
To use Micro Focus Rumba on a TS/Citrix machine, ensure you install a license for this type of
environment. Contact Micro Focus Sales for more information.
ViewNow Installation
To use ViewNow on a TS/Citrix machine, ensure you install a license for this type of environment. Contact
Micro Focus Sales for more information.

Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Product Support. In the Browse by Product field, click the product you
require support for. Click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
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The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.

•

Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
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4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.

Copyright and Disclaimer
Copyright © Micro Focus 2017. All rights reserved.
The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
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5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

On Windows
Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product.
To install ViewNowX:
1. Using Windows Explorer, navigate to the folder that contains the ViewNowX executable. By default, this
is %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\ViewNowX.
2. Execute ViewNow_X_Server.exe and then vnx_HF_11327.msp in that folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing on Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Note: The installer creates separate installations for Micro Focus Enterprise Developer and Micro
Focus License Administration. Uninstalling only Enterprise Developer does not automatically uninstall
the Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
Some registry entries are not removed by the uninstallation process and you need to manually delete
them.
The following folders might not be removed:
•
•
•

The Micro Focus Product Name folder in the Start menu - you can delete it manually.
%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
%ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
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•

%Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall
In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:
•
•

Micro Focus Server\Performance\Active Servers
Micro Focus Server\Performance\PerfIniFile

On UNIX
Configuring the Remote System Explorer Support
Note: The following only applies if you are using Micro Focus Enterprise Developer UNIX
Components with Enterprise Developer for Eclipse.
The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.
Configuring the Environment
You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.
Starting the Daemon
Important: Before starting the daemon you must have the following on your UNIX machine:
•
•
•

A version of Perl.
A version of Java 1.7 or later.
The as (assembler) and ld (linking) programs on the path, as specified by the PATH environment
variable.

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:
$COBDIR/remotedev/startrdodaemon
The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.
The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:
$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>]
where:
•
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<port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,
$COBDIR/remotedev/startrdodaemon 4999
•

This command will start a daemon listening on port 4999 and will use random server ports.
<low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.
For example,
$COBDIR/remotedev/startrdodaemon 4080 4090-4999
This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon
To stop the daemon, type the following command with superuser authority:
$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.
To uninstall this product:
1. Execute as root the Uninstall_EnterpriseDeveloper3.0.sh script in the $COBDIR/bin
directory.
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:
•
•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration
Windows
Windows 7 and Earlier

•

From your desktop, click Start > All Programs > Micro Focus
License Manager > License Administration

Windows 8, 8.1, and
Windows Server 2012

•

From the Start screen, click the License Administration tile

Windows 10 and Later

•

Click Start > Micro Focus License Manager > License
Administration

UNIX
Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a 16digit string of letters and numbers.

If you have a license file
Windows
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.
Alternatively, you can install the license file from within the IDE as follows:
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1.
2.
3.
4.
5.
6.

Start Enterprise Developer.
Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
Ensure I have a full Enterprise Developer Team Edition license is checked.
Click Browse next to the License file field.
Select the license file (which has an extension of .mflic), and then click Open.
Click Finish to install the license.

UNIX
1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
UNIX
1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.
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The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.
UNIX
In order to authorize your product you must have the following:
•
•
•

Access to a computer which is connected to the Internet.
Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Product Support. In the Browse by Product field, click the product you
require support for. Click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
Copyright © Micro Focus 2017. All rights reserved.
The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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